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Chapter 1

INTRODUCTION TO GIS



What is a Geographic Information System?

“A GIS connects where with what” 
A Geographic Information System collects, stores and manages the location and geometry of features 
(the “where”) along with the attiributes of those features (the “what”). By utilizing computer 
technology, this connection between where and what allows for powerful analysis and decision-
making support.

The basic building block of a GIS is a “feature”
A feature is a computer model of a real world object (e.g. a river) or a concept (e.g. a boundary). Thee 
computer model consists of one or more coordinates (x, y, z or latitude, longitude, altitude). 

A feature1 may be a single point in space or an ordered list of points (line2). A line may be closed to 
form a surface (polygon3). Theere is also fourth type of feature used to display images (e.g. satellite 
photographs) called “raster images” in combination with the above “vector” features4.

Features can be more complicated in that a single feature can consist of multiple parts. Lines may 
have breaks and polygons may have additional disjoint parts (separated surfaces that are identifiled 
as the same object). Polygons may also have any number of holes (called islands)5.

1 Thee term feature is unfortunately used a lot in softwware and technology to describe a specifilc benefilt of a product, i.e. 
central locking in a car is a “feature” of the car. In GIS, feature is the term for an identifilable object on a map (more 
accurately defilned above). When describing the softwware itself, alternative words like “function” must be used in the 
GIS world.

2 A “line” is technically a connection between two points, but in GIS “line” is short for “polyline” (multiple connected 
points).

3 A “polygon” in GIS is a closed polyline, but it is usually the surface area enclosed by the polygon which is being 
modelled. With polygons, a GIS more oftwen answers the question: “is a point inside or outside of the polygon?” than 
the question “what is the surface area’s boundary?”

4 “Raster” means a rectangular grid of pixels (cells), where each pixel is a colour or other (e.g. elevation) value. “Vector” 
here means a mathematical model of a shape (feature). Raster images are actually positioned with vector rectangles.

5 And islands can have internal surfaces, which may again have islandsN
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Attrributes
Each feature has a unique number (called a FeatureId). Each feature may have a label (text to display 
on a map) and a measurement. Point features may have an orientation, line features have lengths 
and polygons have perimeters as well as surface areas. Areas and perimeters/lengths are 
automatically calculated and updated by PlanetGIS.

Any piece of information connected to a feature is called an attrribute. Some attiributes may be unique
identifilers (called keys) that can be used to retrieve information from a database or spreadsheet or to 
be used to locate the feature. A user-defilned identifiler or code is an example for a key, and PlanetGIS
has an attiribute defilned by default, named “Key1” that can be used for this purpose. (Additional 
attiributes can be defilned by the user and used as keys).

Photographs, sketches, documents, multi-media & web links are other forms of attiributes.

Feature classes
Features are classifiled into feature classes (e.g. rivers or roads) which may be further classifiled into 
subclasses (e.g. paved roads or dirt roads). All features of a feature class have the same attiributes and
subclasses may add more attiributes to those of their parent class.  For example, features in a feature 
class “Rivers” might have an attiribute specifying whether it is perennial or not. 

Features are also grouped into feature classes to use the same appearance on the map (colour, 
thickness, etc.) but through the use of thematic mapping, classifilcations may be done based on 
attiributes (e.g. perennial [solid line] or non-perennial [dottied line]).

Map composition
A GIS map is built from a set of layers (called displays). Each display references either a feature class 
or a thematic layer. Thee user can control drawing order, visibility and the minimum and maximum 
scale at which each display is visible.

Displays use styles to defilne their visual appearance. Styles are collections of symbols, pens, fillls & 
fonts.

Finally, views are diffeerent sets of displays that may be set up for diffeerent mapping purposes or 
themes for the same geographical area (e.g. water services are normally displayed separate from 
electrical services).

Advantages of using a GIS
Among many other things, a GIS enables you to:

• Capture & store spatial entities & their attiributes.

• Visualize spatial data to reveal relationships, pattierns & trends.

• Share information in a form that is easily understood.

• Manage updates to your database over time.

• Integrate with existing systems.

Summary of Concepts

Feature
A computer model of a real world physical object (river) or invisible concept (border).
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Feature types
Features can be points (single coordinate), lines (multiple connected coordinates) or polygons (closed
lines, possibly with holes/islands).

FeatureId
A unique number that identifiles a feature within a database.

Attrribute
Information attiached to a feature. Can be a number, text, photograph, etc.

Key
An attiribute that is indexed (and usually unique) which can be used to identify or locate a feature.

Feature class
Features of similar type belong to the same feature class. Specifilcally, all features of a feature class 
have the same attiribute filelds. (Not the same attiributes, which are data items, but attiribute filelds, 
which are spaces for entering & storing data items).

Thematic classification
Features can be classifiled between diffeerent thematic layers, based on the values of their attiributes. 
In PlanetGIS these are usually called “thematic queries” due to the similarity to a database query 
which can be a fillter (sub-selection), grouping (classify by value) or ranges (classify by range).

View
A special “theme” or collection of map layers which has been set up for a specifilc purpose.

Display
Displays are references to feature classes or thematic layers and an associated style. A view is a 
collection of displays.

Style
A style defilnes the visual appearance of a display. A style is simply a named collection of drawing 
elements that can be used and reused for other displays. Drawing elements are pens, fillls, fonts and 
symbols.

How to use this guide
Theis user guide was designed to be read in sequence, skipping any sections that you deem 
unnecessary at the time. Recent versions of this document is nearly identical to the PlanetGIS 
Training Manual. Thee content was developed during three years of presenting hands-on training 
courses by the author. Over time the PlanetGIS training course was developed to be suitable to both 
beginners and expert users. Because of this, parts of this guide will go into more detail than is 
required for introductory purposes.

Theis guide therefore aims to be both structured training and a reference manual. Thee beginner user 
should keep this in mind and skim over parts that are not immediately applicable to the user’s work. 
Wherever this guide goes into seemingly too much detail, the reader is reminded to take note for 
future reference. Content and index pages can be used to locate sections for future reference.
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Notes
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Chapter 2

INSTALLATION AND LICENSING



Installing PlanetGIS

Requirements
PlanetGIS requires the Microsoftw Windows operating system (NT/2000/XP/2003/Vista/7/8/10), a 
minimum of 512MB of available RAM and 30MB of hard disc space for installation. For installation 
to the Program Files folder, you will also need administrator’s privileges.

PlanetGIS can be run on Apple and Linux computers with the use of Wine, other emulator or a 
virtual machine1.

Downloading the installers
Thee latest versions of PlanetGIS can always be found on the download page: 
httips://planetgis.org/download.php. If you have softwware licenses, download links will also appear 
on your profille page (httips://planetgis.org/profille.php).

For downloads other than PlanetGIS Explorer (see licensing below), you need a user account on the 
PlanetGIS website. Creating an account is free and can be cancelled at any time.

When you download any version other than Explorer, you will be sent a license key via email. Theis 
should arrive before your download completes. If not, you will see it on your profille page (link 
above).

Updating an existing installation
It is not necessary to uninstall an existing installation of PlanetGIS. Simply install the latest version 
to replace a previous version. Some people like to keep older versions in which case you can simply 
rename the “Planet?nn.exe” to include a more complete version number. When there is a switch to a 
new “major” version number, e.g. 5.0 to 5.1, the names of the executables will be diffeerent and you 
will have both versions installed. (See next paragraph). You can simply delete an older .EXE and the 
shortcuts you may have to it on your desktop, start menu, or task bar.

Multiple versions
Each successive version of PlanetGIS either filxes defects, improve functions or add functionality. 
(Oftwen all of the above). New functions can oftwen be negatively affeected by opening (and saving) a 
project with an older version. Theis is because older versions cannot save any options and settiings 
you specify, of something the older version doesn’t know about. For example, some new “widget” 
that can flooat on top of a map, will be lost when saved with a version of PlanetGIS that doesn’t know
about the new “widget”. In reality, this is rarely a problem if you have multiple versions starting with
the same whole number. (E.g. mixing 5.0 and 5.1 will in most cases not be a problem, but avoid 
opening a project that has been modifiled in 5.1, with, e.g. 4.3).

Installation procedure
Installation normally takes a handful of seconds and about as many clicks. Installation filles will look 
like one of the following:

• Planet63Install.exe

• Planet63Trial.exe, or

• Planet63_64Install.exe

1 See the FAQ on the PlanetGIS website for your options: httips://planetgis.org/faq.php?za&faqtype=1#25
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Thee numbers provide the major version number, and _64 means it is a 64-bit installer fille. Unless you
are using a 64 bit installer, make sure you choose the 32-bit location for program filles. (Normally C:\
Program Files (x86) on 64-bit systems).

For PlanetGIS Explorer (installer fille starts with PlanetEN) you don’t need to enter any further 
information, your installation should start and complete in a few seconds.

Other versions of PlanetGIS require you to enter a user name (any name of your choosing), an 
organization name and a license key. Thee lattier two must be entered exactly as supplied (though 
capitalization and spacing is ignored).

Using PlanetGIS without an installers
If you do not have access to C:\Program Files (e.g. no administrator’s privileges), you can install to
any other location allowed by your operating system, e.g. D:\PlanetGIS. If you don’t want to use an
installer (or move/copy an installation from one computer to another), simply copy everything in the
C:\Program Files (x86)\Planet GIS2 folder to another computer. You can launch PlanetGIS by 
double-clicking on the .EXE fille. Be sure to also copy IJL15.DLL and SQLITE3.DLL. Planet will work 
for most projects without any of the other filles.

Theis is most useful when sending someone a GIS project on floash drive or external hard drive. 
Sometimes users do not want to install additional softwware, or do not have permission to do so. Theey
can simply double-click on the Planet?nn.exe fille to run PlanetGIS! You can also create a shortcut on 
the desktop (and elsewhere) to include the name of a project fille (.db), so that the map will be 
automatically opened. (Be sure to enclose the whole path to the .db fille in double-quotes if there are 
spaces in the path).

Softwware licensing

Free softwware
PlanetGIS Explorer is completely free and is suitable for students and casual users that do not 
require all the functionality available in the standard version.

With “Explorer” you can set up GIS projects, change the appearance of maps and even import 
information (e.g. from shape filles). Starting with version 6, Explorer allows capturing and 
modifilcation of features as long as the features belong to feature classes inside an “Annotations” 
main feature class and the user is limited to capturing 1000 features in total inside this group.

Explorer has enough functionality to be used as “trial softwware” for users that are considering 
purchasing a softwware license. Explorer can be used for the all the exercises in this guide up to 
Chapter 10.

Licensed softwware
If the functionality provided by PlanetGIS Explorer is not sufficcient for your work, you need to 
purchase a softwware license.

Softwware licenses can be purchased from our website: httips://planetgis.org/order.php Please note 
that any data purchases do not include softwware licenses. (All data products can be used with 
Explorer).

A softwware license gives you access to priority email support and softwware updates for a year aftwer 
purchase. Theis includes “major” updates, not just improvements to your current (main) version.

2 Note “(x86)” might not be part of the path if your operating system is 32-bit.
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Important: Licensed softwware does not expire. You will be able to use the softwware indefilnitely. 
What does expire? Web updates (see below).

Educational or non-profit usage
In the majority of cases Explorer is sufficcient for educational or private use.

Non-profilt organizations may apply for softwware licenses at reduced or no cost.

Multiple users
Thee PlanetGIS licensing scheme is per user. (Theere is no “network license”). Thee license fee for 
additional users is steeply discounted. “Additional users” must be co-workers. Theis usually mean that
they are in regular contact with each other. Large organizations with groups in diffeerent locations 
must obtain a separate license key for each officce.

Multiple installations by one user
Every user can install PlanetGIS on as many computers as required for use by that user. Theis 
includes e.g. additional laptops, tablets or home computers. While each installation must be 
registered (in order to update), there is no limit placed on registrations.

Ad-hoc users
Organizations may also install PlanetGIS for additional users that infrequently need access to the 
organization’s projects. Explorer is oftwen sufficcient for this, but other installations are allowed.

Softwware registration
PlanetGIS Explorer does not require any license key, registration or even a user account on 
planetgis.org. 

Other versions of PlanetGIS require you to register the softwware before you can update it to a new 
version. Theis requires you to have a user account on planetgis.org. Some organization use only one 
user account for everyone’s updates. Theis is quite acceptable, but it is easier to keep in touch with 
our users if every person creates their own account. Thee process of softwware registration combines 
user accounts with organizations’ license keys.

If you have not registered each installation, you will be prompted to do so before installing a new 
version. All you need to register an installation is the email address used to create a user account on 
planetgis.org and your 5-digit password. (Your password will be in an email sent by the system when
you created an account. Theere is also a “Forgot password” link on the website to have it emailed to 
you again).

For quick, online registration, you need to have Internet access on the computer with the softwware, 
and the PlanetGIS softwware must be allowed by the filrewall to send and receive information to 
planetgis.org or planetgis.co.za.

To register your PlanetGIS installation, click Help→Register softw�are.

Softwware updates

Automatic checks
PlanetGIS will occasionally, on startup, attiempt to contact the PlanetGIS website to see if a newer 
version is available. If your system’s filrewall allows such check, PlanetGIS will notify you if any 
updates are available. You can also see the updates in a list, in order to decide if updating is 
necessary. You can manually check for updates by clicking Help→Check for updates.
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Web updates
Web updates provide the latest versions of PlanetGIS to users with active update subscriptions. 
Updates are downloaded from the PlanetGIS website and then installed on client computers. Web 
updates are active:

• For one year aftwer purchasing a softwware license

• For 6 months aftwer obtaining a trial license

• For subsequent years upon purchasing web updates

• For one year aftwer purchasing an upgrade (see below)

Additional years of web updates cost 25% of the cost of a new license. When web updates are 
renewed, the previous period’s updates are extended by one year. When purchasing web updates 
aftwer the expiration period, therefore, will extend the update period for one year since the last expiry
date, not the date of purchase.

Ad-hoc upgrades
Web updates are optional. An alternative is to purchase an upgrade when the user is ready to move 
to a newer version of PlanetGIS. An upgrade of a license is always 33.3% less than the full price at 
the time of purchase.

Important: An upgrade does include one year of web updates.
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Chapter 3

GETTING STARTED WITH PLANETGIS



Introduction
In this section you will be introduced to all the essential elements for using and customizing an 
existing PlanetGIS project and to produce output from it. 

Opening a GIS Project
PlanetGIS project filles have .db extensions.  In this guide, the word
“map” will sometimes be used as a short form for “PlanetGIS
project”.

When launching PlanetGIS, you will be presented with a “Quiick
start” window which lists all your recently opened projects.
Alternatively use the File menu which also maintains a list of
recent projects. Thee following examples use the World map which
is available here: httip://www.planetgis.co.za/browsemap.php?id=12

Files used by a PlanetGIS project
PlanetGIS project (.db) filles are databases that store the structure of the project, e.g. views, displays 
and styles, as well as spatial and attiribute information.

Other filles that will be created automatically if they are not present are:

• .index – Spatial index used for drawing the map. If not present it will be recreated from the 
geometry of features stored in the .db fille.

• .local – Contains information relevant to a particular user that would typically not be 
shared with other users. Examples are the content of SQL tabs, fillters on tables and the last 
location in a map when the project was closed.

• .blobs – Stores attiachments (photographs, documents, etc). Theis fille is separate from the 
main database for easier regular backups of the main database.

• .shadow – Stores all changes to the database, including by other users in a shared project.

Locations for PlanetGIS projects
PlanetGIS project filles need to be together in a folder (directory) on your local hard drive, a network 
drive or external storage. PlanetGIS must be able to create filles in this folder. It is therefore not a 
good idea to create folders for your projects anywhere under C:\Program Files or (C:\Program 
Files (x86)) because Windows typically restricts softwware from creating their own filles in this 
location. An easy location like C:\PlanetMaps works well.

Saving changes
Starting with version 6, PlanetGIS does not require changes to be saved and instead saves any 
changes immediately to the database. It is important to make regular backups in case you need to 
revert to a previous version.
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The User Interface

If you pause the mouse over most elements shown above, a small “tool tip” will appear that explains 
the element's function. A longer explanation will appear in the hint bar at the bottiom. Thee filrst six 
buttions of the map toolbar are mutually exclusive “click modes”. Each changes the way that the 
mouse will interact with the map. When the mouse is over the map, notice how the hint bar tells 
you how you can use the mouse to interact with the map. A mouse with a wheel is recommended. 
Rolling the wheel will change the position on the scale bar, zooming in or out with the location at 

the mouse cursor remaining stationary. In zoom mode ( ), clicking on the map will move the 

map so that it is centred around that location (and zoomed in). Right-click zooms out. 

In all modes, right-click and hold the mouse buttion down for ½ second to see a menu with many 
useful items.

Map toolbar

 Tag: In this mode a map feature is selected while the existing selection is cleared. <Ctrl> 
changes the click mode into “Tag multiple” and <Alt> changes it to “Untag”. Alternate selection 
modes will appear to the right of this buttion when the mouse cursor is over the buttion.

 Info: Theis mode is the same as Tag mode except that the attiribute information window pops up 
on top of the map every time you select a feature. Use Tag with the Attributes tab instead unless 
you have a large or multiple monitors.
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 Measure: In this mode you can measure distance, direction and area. Click once on the map to 
indicate the starting position of a measurement and move the mouse in the direction of 
measurement. Thee distance from the start location, direction and bearing is displayed in the scale 
box. Thee total distance will be updated continually as you move the mouse. Click one or more times 
to filx a coordinate and create further line segments. If you keep the mouse buttion depressed, a path 
will be captured with many points as you move the mouse. To measure area, return to the starting 
point. Clicking at the starting point clears the measurement polygon. Thee <Esc> key cancels the 
current measurement.

 Capture: In this mode you can place your own points, lines or polygons on the map. Alternate 
capture or modify “click modes” will be shown to the right of this buttion when the mouse cursor is 
over the buttion.

 Zoom: In this mode you can click on the map to centre that position and reduce the scale by ¼, 
or alternatively click and draw a zoom rectangle by moving the mouse while keeping the the leftw 
mouse buttion down. Right-clicking – as with most other modes — will zoom out by doubling the 
scale.

 Pan: In this mode you can change the viewing location of the map without changing the scale. 
Click on the map and drag (move mouse while leftw buttion is held down) to “pan”.

Thee next 5 buttions do not change the click-mode selected above. Theey all perform a single action 
which usually do not need to be repeated.

 Zoom all: Display the map to its full extent or if the maximum extent is limited, zoom-all will 
go to that limit.

 Zoom previous: Revert to a prior location and scale. Theis is similar to “undo” for zooming and 
panning operations. All locations since opening the map is remembered.

 Zoom tags: Fit selected features onto the screen, zoomed in as close as possible.

 Clear tags: Clears all tags and empties the selection.

 Redra�: Re-renders the map on screen.

Menu toolbar
Thee buttions at the top are shortcuts for items in the main menu.

File & print
Buttions correspond to items in the File menu:

 Ne�: Create a new PlanetGIS project.

 Open: Open a PlanetGIS project.

 Print previe�: Changes the view mode to visualize the map as when printed on paper as per 
the currently selected printer and page size and orientation. (File→Print setup to change). Click 
again to change to normal map view.

 Print: Prints current view at current scale.
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Application interface mode

 Map: Thee map is visible (default mode).

 3D: 3D viewer.

 Design: Design mode exposes the entire structure of all open projects. Oftwen operations are 
more efficcient in this mode.

 Database manager: Direct access to the internal as well as linked databases.

Map tools
Common mapping actions, e.g. locating features which will be demonstrated later in this guide.

Expanding tabs
Thee tabs on the right of the user interface expands once you click on them and can be collapsed by
the small arrow at the top. Each tab serves a diffeerent purpose as explained below. Thee content of
the tabs are determined by the currently active view and the current selection of features on the
map.

If enough vertical space is available the names of each tab will be visible, alternatively only the
icons are displayed and you have to move your mouse over each to see the tab’s name.

Thee expanded area of the tabs can be resized by dragging a “splittier” between the tabs’ content area
and the map scale trackbar. 

Legend: Legend display for the current view at current scale. Exactly the same content as the
legend that could be displayed as a flooating object on the map or inside a print frame.

Displays: Thee Display Manager controls what displays are added into a view, which displays
are visible, the order of displays and more.

Selection: Shows exactly what has been selected on the map, and counts by feature class. Can
be used to refilne the selection.

Attributes: Displays all attiribute information of selected features. Can also be used to change
the selection on the map.

Attachments: Displays all attiachments (photographs, documents, etc.) linked to selected
features. Documents can be viewed, added and deleted.

Forms: A custom input area that can be defilned for each feature class. Thee input filelds
correspond to the display on hand-held data collection devices.

Coordinates: Tools for making changes to the geometry of a selected feature.

Pan & scale trackbars
Use the East-West and North-South pan bar directly next to the map area below and to the right to 
“pan” the visible area of the map as desired.

Thee scale trackbar has levels of rounded and commonly used scales. Thee scale trackbar corresponds 
to each position of the mouse wheel when rolled forward or backward slowly. (Thee mouse wheel 
will skip scale levels when rolled continuously for speeding up zooming).
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The status bar
Thee status bar at the bottiom of the screen has four areas:

• Hint bar: Displays hints and descriptions based on the location of your mouse cursor. On the
map the hint will described commonly used actions that you can perform with your mouse, 
based on the current mode of operation. Outside of the map, the hint will describe the user 
interface element (buttion, tab or menu item).

• Scale: Current scale of the map. Click to change to a specifiled scale.

• Coordinate: Thee map coordinate of the mouse cursor. Click to change the format.

• Coordinate system: Thee name of the coordinate system of the active map. An asterisk at the 
end indicates a secondary coordinate system (not the actual coordinate system of the map).

Views
A PlanetGIS project has at least one view and by default this view will
have the same name as the project. You can create any number of
additional views of a map. Views are shown as tabs at the top of the
map. When selecting a diffeerent view, the same geographic location is
displayed but with a diffeerent set of displays (and usually a diffeerent appearance). Theere are two 
main reasons for creating multiple views:

1. To display diffeerent themes (e.g. displaying population instead of land cover or separating 
e.g. water utilities from electricity).

2. To set up views for specifilc purposes. You may want separate views used for printing and it 
is a good idea to have special views for capturing features.

To manipulate views, right-click on a view tab (Figure 5 shows how to add a view).

Views can also be created in a hierarchical structure where
you have views within views. An ellipsis (N) will indicate
that a view has sub-views. Theis is useful to reduce the
number of top-level tabs, create a logical structure and re-
use a group of displays. For example, you can have your
background displays (e.g. country borders) in a parent
view and diffeerent themes overlaid in sub- or “child” views1. By default child views will filrst draw 
the displays of parent views. Theis can be switched offe in the view's properties.

Thee “Select view” buttion in the menu bar ( ) also lists the views and is mostly helpful only if there

is a hierarchy of views.

Displays
Displays are similar to layers in Computer Aided Design (CAD) softwware. In PlanetGIS, a display is a
reference to a feature class or a thematic layer (classifilcation). A view is a collection of displays. A 
display acts as a link between a view and a feature class or a thematic layer2.

1 Thee terms “parent” and “child” are from mathematical and computing “graph theory”, which is a system of organizing 
information into a “tree”. Thee tree starts with a “root” node which has sub-nodes (also called “child nodes”). Thee 
“parent node” is one level up in the hierarchy. You will filnd this concept almost everywhere in Planet, so you will soon
be very familiar with parent-somethings and child-somethings.

2 We will use the word “layer” to refer to thematic classifilcations and sometimes feature classes. PlanetGIS doesn't have 
the concept of layers as does CAD softwware, but a display works similarly to a layer and for thematic queries, results 
are separated (classifiled) into layers.
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Figure 4: View tabs

Figure 5: Adding a view



Thee visual appearance of features is determined by the style that is selected.
While feature classes and thematic layers have their own default styles, the
display ultimately defilnes which style is to be used for a layer in a
particular view. A display therefore also acts as a link between a layer and a
style.

Displays have many properties that control when and how to display a
layer and how features are labelled.

Thee visibility of layers is indicated by the eye icons and controlled by
clicking on the eye icons. Thee yellow
question mark indicates that a display's
visibility is dependent on scale. As you
zoom in on the world map, you will see
more “eyes opening” in the “Places” group.

Figure 7 shows a popup menu when right-
clicking on an “eye”. Here you can use
“Show all” or “Hide all” for controlling the

visibility of all displays in a group.

Adding displays into a view
You can click anywhere on the white space in the Display Manager
or right-click on a display to add displays. Figure 8 shows the
selection of two feature classes to add to the display list. Multiple
selection is done by holding in [Shiftw] or [Ctrl].

Ordering displays
Displays are listed in the order in which they are drawn. Thee
topmost display is drawn filrst and so on. If you think of displays as
layers, the topmost display is the bottiommost layer. However, by
default, Planet uses “smart draw ordering”. Planet will filrst draw all
raster images, then fillls (of polygons) then lines/outlines, then
symbols and lastly text (labels). Within each of these steps, displays
are drawn in top-to-bottiom order. As an example, if you drag the
“Landcover” display to the bottiom of the list, the map will look the
same: the land cover raster image does not obscure anything.  If
you switch offe smart draw ordering, the landcover will obscure everything else. It is therefore good 
practice to place raster displays at the top of the display list. (“Smart draw ordering” can be switched
on and offe in the view’s properties [right-click on the view tab]).

With smart draw ordering switched on (the default), only the order of displays with similar style 
elements are important. For example, in the World map the “Sovereignty” display (switch it on if you
want to test) must be before (above) the “Urban areas” and “Lakes & dams” displays, otherwise the 
lattier will be obscured by it. Similarly, if you want one display’s pen to be
drawn on top of another’s that display must be lower in the list.

To change the order of displays, simply by drag them to a new position. Care
needs to be taken with grouped displays and this applies to many other
places in Planet where items can be dragged to new positions: if you drag-
and-drop a display onto another display that is a group of displays, the

Gettiing Started with PlanetGIS 22

Figure 7: Switching off  all displays in a
group

Figure 9: Avoiding dragging a 
display into a group

Figure 8: Adding a feature class as a 
display

Figure 6: Thre Display Manager



dropped display will go inside the group. Figure 9 shows dragging of a display to the right of a group
display. Theis will place the “States & provinces” display aftwer “Places” instead of inside.

Display properties3

Figure 10 shows the General tab of the display
properties. On this tab you can change the
display's name (if required to be diffeerent
[perhaps more descriptive] than the name of the
feature class), select a diffeerent feature class and
select a diffeerent style.

Theere are many settiings & options (properties)
for displays. In this section we will only look at
the visibility tab. Here you can make a display to
be “scale conditional”. Theis is immensely useful to
speed up map rendering and de-cluttiering maps
containing lots of features. Also, Figure 10 shows
a second item in the menu (“Style propertiesN”)
which is a shortcut to take you directly to the assigned style.

Styles
A style is simply a named collection of style elements. Theere are
four types of style elements:

• Pens
• Fills
• Symbols
• Fonts

A style can have any number of these elements. In Figure 11 there
are two pens: one is used for small scales (global, continental) and
the thicker, coloured pen is used for larger scales (when only one or
a few countries filt onto the map)4. You can also specify a style
element specifilcally and exclusively for printing, on-screen or quick
display. Thee effeect of individual style elements is determined by a complex set of conditions.

All feature types (points, lines, polygons) can display a label (using a font) and a symbol. A symbol 
will be used to display a line or polygon that hasn't any visible pens or fillls. Theis is sometimes useful 
when you need to show lines and polygons at a small scale where they would be invisible otherwise.

In some cases it is useful to only see the label of a line or polygon feature (e.g. the name of a 
mountain range). To accomplish this, pens and fillls need to be invisible at the current scale and the 
display properties need to have “label invisible features” set.

Only polygons will use fillls and only polygons and lines will use pens.

3 Nearly everything in Planet has “properties”. Properties are settiings or user options that are stored for each item. In 
this guide we will oftwen use a phrase like “in the something properties” which will mean: “in the window (dialog box) 
that displays all the options and settiings for this something”. You can almost always right-click on an item to see a 
popup-menu which nearly always will have “PropertiesN” as the filrst item.

4 Thee terminology “small scale” and “large scale” can be confusing because a small scale has a large number in the 
second part of the one-to-number ratio (1:n). A small scale (e.g. looking at a whole continent) could be 1:10 000 000 
while a large scale (e.g. looking at a suburb) could be 1:10 000. Mathematically, it makes sense when you realise that 
scale is a fraction of 1, i.e. the fraction 1/n.
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Figure 10: Display Properties window / dialog box

Figure 11: Thre Style Properties window



Common aspects of style elements

The Colour Picker
Planet has an extremely capable colour selector
(/picker). Thee “colour wheel” provides the full range of
colours at a particular “lightness” (/shade). Click
anywhere on the wheel to select a colour. Slide/click on
the “lightness” bar to select a shade (amount of black
mixed in for the colour wheel). Thee centre of the colour
wheel is achromatic (a shade of grey).

Alternatively, click on a coloured or grey-scale cell in
the “quick pick” area. You can also build your own
palettie of oftwen-used colours by clicking on “Custom
palettie”.

For precise colour selection, you can enter either Red-
Green-Blue values between 0 and 255 or Hue-
Saturation-Value values. Sliding any of the 6 black
triangles to the leftw or right is an efficcient method to
adjust a colour to your liking. R-G-B corresponds to
how colour is mixed on a computer screen and H-S-V corresponds to how colour is mixed by a 
printer.

Hue is a value between 0 and 359 which corresponds to the degrees of arc around the circle that is 
the outer edge of the colour wheel. Red is at 0 degrees, green at 120°, etc.

Saturation is a measure of how much white is mixed in (tint). A fully saturated (pure) colour is on 
the outer edge of the colour wheel, while the centre of the wheel has no colour. Changing saturation
changes the distance of the selected colour between the centre and the outside of the colour wheel. 
For printing, you would typically reduce Saturation if a colour is too bright (and to save ink). 

Value is a measure of how much black is mixed in (shade). Changing Value (or lightness / shade), 
changes the entire colour wheel, similar to how all available colours will appear darker in low light 
conditions. Text and lines that need more contrast to stand out will typically need a reduction in 
Value, while solid fillls will typically need a reduction in Saturation.

Thee “Dropper” sampler

Thee “dropper” is a very convenient tool to select a colour from something else already displayed on 
your screen. It is a good alternative to building your own custom colours (palettie) if you want to 
restrict the colours that you are using to a filnite set.

Click on the dropper buttion and then anywhere on the map or any area that is part of Planet to 
select the same colour. To pick a colour from another application you need to have both Planet and 
the other application visible on the same screen (or on multiple screens). Planet needs to keep the 
focus to sample the colour, so the procedure is slightly diffeerent: click on the dropper buttion and 
keep the leftw mouse buttion down; move the mouse to the colour you want sampled; only release the 
leftw mouse buttion once you have the desired colour under your mouse cursor. 
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Figure 12: Advanced colour picker



Visibility
Every style element has the option for displaying either for on-screen, printing or quick display. In 
addition every element can be selected to display for a range of scales. For styles that have child 
styles (for use with groups of feature classes or thematic queries with sub-groups of either groups or
ranges) a parent style can be made to be applicable or not. 

Units of measurement5

Thee width and height of pens, fonts, symbols, etc. can be specifiled in either “paper units” or “real 
units”. Paper units are filxed, while real units are real-world dimensions. For example, if you set the 
font for street names to “8m (real)” the street names will always have the height equal to roughly the
width of a residential street. Theis can be useful at large scales, but the street names will soon become
invisible as you zoom out to smaller scales.

Never use px (pixels) if you intend to print your map. On a typical screen, one pixel is about 0.25mm 
but on a typical 600dpi printer only about 0.04mm.

Font properties
Fonts are a combination of a typeface, a style, size, colour and effeect. Thee Typeface is the name of the
font given by the designer (e.g. “Times New Roman”, “Arial”, “Georgia”, “Helvetica”, etc). Thee style 
can be a combination of italic, bold and underlined.

Fonts can also have a background 
effeect to make them more visible. 
You can specify a solid colour for a 
background, a “halo” of lighter 
colour can make text more visible 
as well as a shadow. Theere is also 
an option to draw a box with an 
outline and filll around the text. 

Symbol properties
Symbols can be either vector shapes or bitmap images. Shapes have the advantage of producing 
symbols at the maximum quality allowed by the output device/printer. Bitmap images have the 
advantage of having unlimited colours. Planet includes about 300 shapes. Click on the shape buttion 
to select a shape. Expand the “Stock” tree node to see groups of shapes.

It is also possible to create your own shapes by capturing features and importing them as shapes.

5 If you are seeing inches selected by default and you are not in the U.S.A. it means that your computer's locale is set to 
U.S. or measurement units is set to “U.S.”. Change this in Control Panel, “Clock, Language, and Region” and set your 
location, or alternatively click on “Additional settiings” in the Region and Language window and change the 
measurement system to “Metric”.
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Figure 13: Thre font properties window



Pen properties
Pens can be either “hairline”, “solid”,
“pattiern” or “shapes”. Hairline implies
a width of one pixel. Do not choose
hairline if you will be printing your
map. Hairline pens do have the
advantage of being very fast. Since
pens are typically used on a large
amount of coordinates, thick pens can
slow down the drawing of your map
considerably. A possible solution to
this is to have separate pens for
“browsing” than for “printing” (set this
in the “Visibility” section). 

Pattiern and shape pens can become
quite complex as seen in Figure 14.

Fill properties
Fills can be either “solid”, “transparent”, “hatch” or “shape”. For transparent fillls, you supply a value 
between 0 and 100% for “opacity”. 0 is completely transparent (invisible) and 100 is completely 
opaque (non-transparent). Good values for opacity are 25 and 506. Please note that transparent fillls 
do not work in PDF documents. Theey do work very well in XPS documents.

6 Planet uses a “dither pattiern” to simulate transparency similar to how printers do it. True transparency requires pixels 
to be blended with the background which means the entire image must be created as a bitmap prior to printing which 
is not practical. Theis means that transparent fillls do not look as good on screen as they do when printed.
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Figure 15: An example of a hatch filll

Figure 14: A complex pen using shapes on vertices



Theere are a large number of hatch pattierns to
choose from. For a “hatch filll”, click on the
hatch buttion to select a pattiern. A shape filll
uses shapes, normally used for point
symbols, spaced out horizontally and
vertically per user specifilcation.

Locating features

Click on the Find buttion ( ) to locate a feature.

With the “Features” node selected, the filrst 1000 features of the map is displayed. Simply click on a 
row to select the feature in the background. Use [Ctrl] or [Shift] to select more than one feature. 

To narrow down a search, filrst select a feature class on the right. As an exercise, select “Countries” 
and then locate “continent” in the long list of attiributes (about 2/3rd down the list).

Select “Africa” to narrow down the list.
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Figure 17: Locating a feature

Figure 16: A few of many available hatches



You can add additional criteria: In the second dropdown list, locate the fileld “gdp_md_est” (Gross 
Domestic Product in millions of dollars, estimated) and select greater than (>) instead of equals (=). 
Now type in a value of 1000000 to see a list of the top 12 economies in Africa (see Figure 19).

Thee SQL tab of the results shows the actual SQL query used to fetch the results from the database.

Saved Locations
Saved locations are like “bookmarks” for a map. You can use Saved locations to return to a specifilc 
place on your map and either at a specifilc scale or a rectangular area.

If you are at a location which you would like to return to, save it by clicking on the Goto buttion (

) in the menu toolbar. Notice that the Goto buttion has two regions: the down arrow on the right 

will display a list of previously saved locations, if there are any (if not it will do the same as a click 
on the leftw side). Thee leftw region of the buttion is therefore actually “save this location”, not “goto”. 

Give the location a name that makes sense to you. Saved locations
have the following properties:

Activate view
If checked, the saved location is also tied to a view. Thee selected
view (or current view) will be activated each time that you “goto”
the saved location.

Limit to this view
If checked the saved location is tied to the selected view in a diffeerent manner: It will only appear in 
the list if the selected view is active. Theis option allows you to have saved locations that are specifilc 
to views. If unchecked, the saved location is always visible.
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Figure 18: Type one or more lettrers to get a list of values found in the database

Figure 20: Saving a location

Figure 19: Top 12 African economies found by additional criterion



Options for how the location is stored
• “Save centre point & scale” - if the scale is more important than the extent.

• “Save visible rectangle” - regardless of screen or paper size the rectangular extent visible 
when saved will be filt such that (if the width/height ratio changes) either the width or the 
height will be exceeded but not both.

• “Save scale only” - a diffeerent kind of location which is not a location, but only a scale. Theis 
option is for when you are working at specifilc scales and need a quick way to zoom to these 
scales while keeping the part of the map in the middle of your screen in the same place.

Limiting your project area
Each view can be limited to the extent defilned by a
saved location. Right-click on a view tab and click 
Properties, then activate the “Activate/Limit” tab.

Check “Limit visible area” and select a saved location as
shown in Figure 21. In most cases where you have
separate views for distinct project areas, you would also
want to check “Zoom when activated” so that the entire
project area will be shown when you switch to the view.

A variation on this would be to zoom to a project area
without limiting the visible area. Theis would add the
convenience of zooming to the appropriate project area
without restricting the visible area (i.e. you can still zoom out to other locations/scales).

Yet another variation is to use a (polygon) feature instead of a saved location. Figure 21 also shows 
the values for using the boundary feature of South Africa. Check “to feature” and enter those values 
to use the feature instead of a saved location.

Design Mode
“Design mode” is an alternate view of your opened projects – a “look under the bonnet”, so to speak.
Every single aspect of your project is accessible here. Design mode is analogous to looking at a 

database table's structure instead of its content. Click on the Design buttion ( ) in the menu 

toolbar to activate Design mode.

Design mode consists of two panels separated by a “splittier” which you can move to assign more 
space to either panel as required. On the leftw is a “tree” displaying the hierarchy of elements of your 
projects, starting with each project on highest level under the “root” which is simply called “Maps”. 
Theis tree is very similar to the folders view in Windows Explorer. Each item in the tree is called a 
“node” and an arrow7 to the immediate leftw of the node indicates that the node can be expanded to 
reveal more (“child”) nodes. In Figure 22 you can see that the “World.db” and “Feature classes” nodes
have been expanded. Thee “Feature classes” node has also been selected.

7 On some systems this is a block enclosing a plus.
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Figure 21: Limiting a view to a saved location



Once a node is selected, you will see that the right panel contains either a list of data items or child 
nodes which are also in the tree view on the next level down. (Feature subclasses are shown in the 
“Subclasses” tab).

In general, Design mode has several very useful functions:

• Right-click on any node to see a menu of possible tasks for that node.

• Right-click on any node and click Properties to see all settiings for that element.

• Create new elements or delete elements.

• Re-order elements and move elements into other elements.

• Create duplicate copies of elements.

• Copy any element to another project (simply drag-and-drop).

Other than displaying database information for feature classes, the right panel (or content panel) is 
useful for performing actions on more than one element at the same time. For example, you can 
select many elements and delete them all in one action, or copy them all to another element by 
dragging them onto a node in the tree on the leftw. Theere are several ways to select more than one 
element:

• Select an element, then press <Shift> and select another element to include all elements 
between (from leftw to right, then top to bottiom).

• Select an element, then press <Ctrl> to add individual elements.

• Position the mouse onto white-space (to avoid selecting something), then drag a rectangle 
touching all elements you require to be selected.

• To unselect individual elements that have been selected, press <Ctrl> and click on each.

• You can also use the drag rectangle method to unselect elements by pressing <Ctrl> when 
completing the rectangle-drag.

To return to mapping mode, click Map ( ) on the menu bar or double-click on the project node 

(“M:\World\World.db” in the example above). Theis will also activate the project if you have multiple 
projects open.
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Figure 22: Design mode with "Feature classes" node selected



Notes
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Chapter 4

MAP PRODUCTION



Introduction
In this chapter you will learn how to set up existing projects for producing maps. Theis includes 
embedding maps into your documents, producing electronic (paperless) maps and paper maps.

All tasks in this chapter can be achieved with the free PlanetGIS Explorer.

Displaying a Map Grid
To display a grid (or “graticule” for a
geographic projection map), right-click
on the view tab as in the previous section
and click Properties. Activate the “Grid”
tab.

To display an automatic grid with text for
the values, select the items as in Figure 
23. A filxed grid can be specifiled, but will
only be useful at a narrow range of
scales. Thee grid interval can be specifiled
in degrees, minutes or seconds (and
fractions thereof) or in the case of a
projected coordinate system (usually)
metres. On a World map, it is typical to
have a 15 degree grid (graticule). (15
degrees is one hour of the Earth’s rotation). If you forget to change from seconds to degrees, Planet 
will not display a grid because there would be too many grid lines.

If grid lines are too intrusive, select “Ticks only” which will draw short lines of the specifiled length 
around the edges of the map and crosses where grid lines intersect.

Floating Objects
Floating objects are elements added to a map that remain in one place on the screen (or printed 
page), regardless of changes to location or scale of the map. To add a flooating object, you need to 
open the map popup menu with a long-right-click (i.e. keep the right mouse buttion down for ½ 
second). Figure 24 shows how to add a “flooating” legend.

Typical types of content for flooating
objects are:

• Text (e.g. a title)

• Image (e.g. a logo)

• Legend

• North arrow

• Scale bar

• Locality map

• Page references

Once you have selected the type of flooating object, a “Floating object properties” window will 
appear. For this example, simply click OK.
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Figure 24: Adding a "flooating" legend

Figure 23: Settring up a latitude/longitude grid



Sizing frames
As soon as you create a flooating object, “sizing frames” will be automatically
switched on. You can click in the interior of a flooating object and drag it to an
appropriate location, or drag the edges to adjust the size. 

When you close your project and re-open it, sizing frames will not be visible.
Theis is the default mode of operation so that you can interact with the map
without flooating objects interfering. Thee only interaction available without
sizing frames is right-clicking inside the flooating object. To switch sizing
frames on or offe, right click on a flooating object and check/uncheck Sizing frames.

Right-clicking on a flooating object also allows you to change its 
properties and hide or delete it.

Common properties of floating objects
Every type of flooating object has the same properties window for common properties which are 
divided into tabs for:

• General. Thee name (only for reference)
and type of content as well as access to
the specifilc properties of the content
(see next section).

• Position. For specifying exact distances
from edges of the page.

• Size. For specifying exact or relative
sizes.

• Visibility. Choose which views to
display the flooating object in as well as
whether it should be used for printing,
on-screen or both.

• Border. For specifying a frame to use
around the flooating object and also what colour to use for its background (if any).

Specific properties of the content of floating objects
You can access specifilc properties for the type of flooating object you have chosen in the General tab 
of the flooating object's properties window.

Use the buttion with the down-arrow to change the type of content or click on the content buttion to 
open specifilc properties.
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Figure 25: Dragging a legend

Figure 26: Floating object menu

Figure 27: Floating object properties; Border tab



Floating text
Floating text is normally used as a title for the map. When you create flooating text, it will appear in 
the default location for a title. Move it to an appropriate location for other uses. 

For a title, your text size should be “auto” and alignment “centre” to size it to filt according to the 
extent of the flooating object. For other uses you may prefer a filxed size and leftw-aligned text.

As part of the text you can use the following “macros” for automatic/variable information: (all lower 
case, no spaces, preceded by $)

$viewname
$longdate $shortdate $time
$coordsys $projection $coordinate
$scale
$filename $fullpath

$viewname is handy to use the name of your
views as titles on the map. Thee date format (as
elsewhere in PlanetGIS) is determined by your
operating system settiings (Control Panel→Clock,
Language & Region). $coordinate corresponds to
the centre point of your map.

Floating legend
A flooating legend is a common addition to a map.
Thee font size should be “auto” for most cases and
use the “multi-column” option together with
options in the “Legend” tab of the properties of displays (Displays tab→Right-
click→Properties→Legend) to control the layout and visibility of items in the legend.

Floating locality map
A locality map provides locational context. Thee default location is top-leftw and offeset by 5mm. No 
frame is used by default.

Options for a locality map are:

• Scale factor: scale of locality map = scale of map x factor

• Choose another view: locality maps must be less complex as in this 
example of the World map that uses the Economy view for the 
locality map.

• Use a saved location for user-specifiled locality.

• Whether and how much to darken the area outside of the visible 
map area.
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Figure 28: Specifilc properties for a legend

Figure 29: A locality map



Callouts
Callouts are elements added to a map that are 
“tethered” to a coordinate. Callouts are used to 
draw attiention to a location or feature and attiach 
content to it. Thee most common type of callout is a
“speech bubble” containing text. Callouts can have 
most of the content types as flooating objects. Only 
the properties for positioning are diffeerent.

When sizing frames are enabled you can move the 
anchor point and the callout independently. Thee 
relative distance between the callout and anchor 

will be maintained and the callout will only be displayed if the anchor point is visible on the map.

Printing & Reporting

Printing
To print the map displayed on your screen, it is advisable to filrst activate Print previe� in the 

menu toolbar ( ). If you skip this step Planet will do it for you, but the print job will also start. 

Print preview shows you what the printed map would look like for the paper size currently selected 
for your printer at the same scale as on your screen when not in Print preview. Thee “page” is scaled 
to filt onto your screen, so will probably look smaller than the hard copy that will be produced1. In 
Print preview mode, the scale displayed at the bottiom of the screen is not the displayed scale but the 
hard-copy scale, so you have to keep in mind that the map is (probably) smaller due to additional 
scaling to filt the page onto the screen.

Print preview shows the selected paper orientation and the printable area. Printers report to the 
operating system exactly how many millimetres from each of the four edges of the paper they are 
able to print2. You can drag each margin to increase the size of the edge, or specify exact values if 
you create a “page frame” (see below).

To select a printer and to change the page size, click File→Print setup.

Paperless printing (eg. PDF)
It is a common task to create PDF (Adobe Acrobat Portable Document Format) filles of maps. Planet 
cannot create PDFs directly, but there are many “PDF creators” that can be installed. Bullzip is a 
popular example (httip://www.bullzip.com/products/pdf/info.php). Theese, when installed, look like a 
regular printer and when you print, a PDF fille is produced. PDF has one drawback in that it doesn't 
support transparency (Planet's transparent fillls appear black).

A littile known alternative to PDF that works well for anyone using Windows, is Microsoftw's XPS 
Document Writer. (XPS stands for XML Paper Specifilcation). Apparently meant to be an open and 
popular alternative to PDF, it is unclear if this format will ever become as widespread in use. You can
create an XPS document on any version of Windows since Vista (unless you uninstalled the XPS 
printer) and any other user of Windows can view and print it3. XPS integrates bettier with printer 
drivers (on Windows) and handles Planet's transparent fillls very well. If you have a map in an XPS 

1 Theese days, with large screens and high resolutions, what you see on screen is very similar to what you will see on an 
A4 page. Try a larger format like A2 or A0 to see a marked diffeerence.

2 PDF & XPS (among a few physical printers) can print right up to each edge.
3 Of course, for users of Mac and Linux systems, PDF is still preferred.
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Figure 30: An "arrow tethered" callout

http://www.bullzip.com/products/pdf/info.php


document, you can still produce a PDF from the XPS viewer which is included in your Windows 
installation by printing it to a PDF creator.

Reporting
Thee easiest way to include maps into your own documents is to copy the contents of the screen to 
the clipboard and paste it into your word processor (or other softwware). Thee copy-to-clipboard 
function is not under the Edit menu, as is traditional, but rather under File, then 
Clipboard→Copy bitmap. Depending on the
softwware and the content of your map, Copy
metafille might work bettier because it is a vector
format that should yield bettier quality when
printing. You need to experiment with it to see
which works bettier for you.

When copying a bitmap or metafille to the
clipboard, a settiings window appears, allowing you
to specify the image resolution (see Figure 31).

You have the option to change the physical size in
pixels or the resolution (as density in pixels per
inch or dpi). While you can change the actual size
to inflouence the resolution, it is not as useful. For
example, a typical computer screen has a dpi of around 100. An image of 100 dpi, however, will not 
look as sharp when printed because a typical printer can produce images at 300, 600 or higher dpi. 
To create an image for including in a document that will be printed, the easiest is to change the 
resolution to 300 dpi4.

It is also important to note the diffeerence in initial settiings when you are in print preview mode as 
opposed to normal viewing. In print preview, you will get the size and resolution for the currently 
selected printer which will produce an image that will take a lot of storage space inside your 
document.

Finally, you can also save images to fille from where you can manipulate them with image editing 
softwware and include into documents at a later stage. File→Save image6 Theis option gives you 
more control over the fille format. For lossless compression (image remains exactly like the original), 
PNG is the best option. If a slight reduction in image quality is acceptable, JPEG is a good option5. 
Aftwer selecting the image fille format and entering a fille name, a settiings window similar to Figure 31 
will appear with additional options related to the fille format.

Print Frames
Thee filnishing touch for printed maps oftwen include a frame (border) around the map. Theis can be set 
up and selected similar to flooating objects. Frames can also be created inside frames, so you can 
create a hierarchy of frames in order to add a title block, for example. Thee possible types of content 
of each frame (other than more frames) are similar to flooating objects.

4 Even on a 600dpi or higher printer, 300 tends to be enough and also saves 75% in storage space as compared to 600dpi.
5 You can control how much the image quality is degraded: 90 would be almost imperceptible, while 60 will yield 

excellent compression.
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Creating & selecting a print frame

To work with print frames, you need to activate Print previe� in the menu toolbar ( ). To select 

and edit print frames, use the “map popup menu” (long-right-click, i.e. keep the right mouse buttion 
down for ½ second on your map. In
print preview mode, unless your click
mode is “Zoom”, a regular quick right-
click does the same). Now follow the
following steps:

1. Click Print frames and 
Select6

2. Click Ne� if creating a new
print frame, otherwise Select.

3. Give the print frame a name
for easy reference. Typically
the paper size and orientation
is used as part of the name.

4. Click Edit to start settiing up
the frame.

Settring up a simple page frame
A page frame oftwen consists of more frames inside it. Thee default
content for a page frame is therefore “Frames”. Thee simplest type of
page frame, however, contains the map at the top level. Thee content
of such a frame must therefore be set to “Primary map”. When
settiing up print frames, one frame must have a primary map, or no
map will be displayed.

Alignment
Frames can be aligned to an edge of the page. An alignment of “All”
means to use all space available to the frame. An alignment of
“None” allows exact placement of a frame. Care must be taken with
a “None” alignment as such a frame can overlap and obscure other frames. An aligned frame (other 
than “All”) requires a size to be specifiled in the “Outer spacing” tab. All measurements use the same 
units as specifiled in the “General” tab.

Border
For a typical page (outermost) frame, a thin-and-thick border is typically used. Use “All sides” to 
select the same line style for all edges. Thee exact widths of lines, spacing and colour can also be 
changed in this tab.

Spacing
Inner spacing is the margin between the content of a frame and its innermost border. In most cases 
this should be 0 for frames containing more frames and at least 1mm for frames containing actual 
content, e.g. text.
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Figure 32: Creating a print frame

Figure 33: Creating a simple page frame



Outer spacing defilnes the outermost measurement of a frame. For leftw/right aligned frames a width is
required (but height is ignored, if specifiled). For top/bottiom aligned frames a height is required (but 
width is ignored, if specifiled). For a page frame (outermost frame) the offesets are the distances to the 
edges of the page. Offesets should be used with care for any inner frame as inner spacing normally 
provides bettier control.

To create a simple page frame for your map, you only need to specify “Primary map” as the content 
and choose a line style in the “Border” tab.  Theen click OK and Close. If you have created the frame 
earlier you also need to click Select.

Settring up more complex frames
Editing and expanding on your print frames will require a series of Map menu → Print frames →
Edit6 (don't click select unless you want to pick another
print frame for your map, although you can simply click
the Edit buttion there to work with the selected frame). 

More complex frames require frames-within-frames. In
order to create frames inside your page frame, you will
have to change the content from “Primary map” to
“Frames” (See Figure 34).

Click Properties, change the content to “Frames” and
click OK. (You will notice your map disappear in the
background).

Now, instead of Edit, click Add and then Inside 
selected frame. (See Figure 35).

On this level you will need at least two frames: one for frame content and one for your map. Figure 
36 shows a print frame with an empty title block (Name: “Title block”, Content: “Text”, Alignment: 
“Right”, Width: 50mm wide and in the Border tab, single line
border on leftw). Be sure to create another frame for the map
with Content: “Primary map” and Alignment: “All”. Click OK
to see your map frames in action.

From here you can add multiple top- and bottiom-aligned
frames inside the title block for a legend, title, project
description, scale bar and company logo. Choose one frame
to be All-aligned, so that it would make use of remaining
space leftw over from the other frames. When multiple frames
have the same alignment (eg. Top), the creation order
determines the actual layout order. You can change the order
in Design Mode (see next section).

Settiing up print frames requires a lot of work and careful
planning. You cannot use the mouse to resize the frames and
must instead supply exact widths, heights and margins. Theis
pays offe in the long run as you can always reuse your frames in other projects and you have full 
control over the layout. You can also create a duplicate set of frames from an existing set in order to 
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Figure 34: Changing the page frame to allow inside 
frames

Figure 35: Adding frames inside frames

Figure 36: Print frames with the beginnings of a title
block



make minor adjustments (e.g. to create a print frame for an A3 page from one created for an A4 
page). For complete control over your print frames, locate them in Design Mode (next section). 

Notes
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Chapter 5

CREATING YOUR OWN PROJECTS



Starting a New Project
To start a new PlanetGIS project, select “Create a new Planet project” in the Quiick start window or 
select File→Ne�6

Aftwer you have specifiled a location and name for your project, Planet needs a coordinate system to 
be specifiled. 

Thee most common coordinate system in use today is WGS84, a geographic projection using 
spherical latitude and longitude coordinates. Theis is also the default coordinate system used by all 
GPS devices. In South Africa, we use Hartebeesthoek94 which is equivalent to WGS84 for most 
purposes. You can select either of these for projects in South Africa that will not be using a local 
coordinate system.

If “All” is selected under “Area of use” you can click on the list of coordinate systems and type “har” 
or you can select “World” as the area of use which will produce a short list containing WGS84. You 
can also explore by expanding “Africa” and selecting “South Africa”.

If you do not select a coordinate system (press Cancel), your project will use a “non-earth” 
projection which is a simple, float, Cartesian coordinate system. Transformation to/from (data 
exchange with) any other “earth” coordinate system will not be possible.

Multi-map Projects
PlanetGIS can combine data from multiple maps (projects). Theis is very useful for adding “backdrop” 
information to your new project. For example, most projects could benefilt from displaying 
administrative boundaries to provide context. You can open any number of additional maps without 
closing any. You can then use the Windo� menu item to switch between them. Design mode will 
show all the maps that are open including secondary maps which will not be displayed in the 
Windo� menu. To view secondary maps, you have to activate them in Design mode (double-click 
on the project node or right-click and click Activate).

Creating your own projects 43

Figure 37: Selecting a coordinate system for a new project



In addition to the Windo� menu, the Map popup menu (right-click for 0.5s - a so-called “long-
right-click” - on the map) provides a function to go to the same location on another map. See Figure 
38.

In multi-map projects, we will use the terms “external maps/projects” or “secondary maps/projects”. 
An external project is simply another project that is opened at the same time as the project which is 
the focus of your current task.  External projects are available to add as displays into your main 
project (i.e. your current focus). A secondary project is a project that has become a dependency of 
another project. In other words, some other project included one or more feature classes as a display
and is now dependant on it. Secondary projects are opened automatically by the projects that 
require them. If a secondary project cannot be found, Planet will ask you to locate it. You can choose
to ignore (click “No”) and the main project will open without it, ignoring displays that reference 
feature classes from it.

If you have multi-map projects which also need to be portable (i.e. able to be run from an external 
storage device) it is important to keep them all in a directory structure where relative paths can be 
maintained between them. Projects on diffeerent drives are not portable if they are part of a multi-
map setup.

You can use the “SA administrative boundaries” map (available here: 
httip://www.planetgis.co.za/browsemap.php?id=13) for the examples below.

Adding external feature classes in the Display Manager

1. Activate the Display tab and click on “Click to add” or anywhere in the white-space below 
existing displays.

2. Locate and expand the external project “SA-administrative.db”.

Creating your own projects 44

Figure 39: Adding external feature classes

Figure 38: Zoom to same location in another map

http://www.planetgis.co.za/browsemap.php?id=13


3. Click on the filrst feature class you would like to add.

4. Press <Shift> and click on the last feature class (alternatively select [or unselect] individual 
feature classes by pressing <Ctrl> while clicking).

5. Press <Enter> to select (or click the “Select” buttion).

Feature classes with thematic queries
You will notice that the “Towns” feature class that you've
selected is not ideal for mapping purposes. A feature class
like this needs to be classifiled into a hierarchy and set up
such that only the more important features are displayed
at smaller scales (zoomed out more).

Figure 40 shows that you can expand the node for the
feature class “Towns” and select a thematic query named
“Towns (levels)”. You could have done this in the previous
step: selecting multiple feature classes with <Ctrl> allows
you to expand nodes without clearing the selection. Thee
steps for selecting a thematic classifilcation for towns
instead are as follows:

1. Hide the “Towns” display by clicking on the eye icon, or delete it by choosing the delete 
option from the popup menu (right-click on the display).

2. Click on “Click to add” or right-click anywhere in the Display manager and select “AddN”.

3. Expand the SA-administrative project and then expand “Towns” by clicking on the arrow 
icon.

4. Select “Towns (levels)”.

Renaming displays
Displays are automatically assigned the names of the feature classes (or thematic queries) they are 
referencing. Within the context of a view, it oftwen makes sense to rename a display to something 
more appropriate. A single click on the name of a display will place the node into edit mode, 
allowing you to rename it. Alternatively right-click and choose “PropertiesN” where you can change 
the name among many other properties.

In this particular case, you might want to rename “Towns (levels)” to simply
“Towns” or even “Places”.

Grouping displays
Thee Display Manager can very quickly become hard to manage due to too
many displays. When layers can be logically grouped together (and especially
with “backdrop” type information), it is always a good idea to create a group
display filrst. 

1. Right-click in the Display manager and click “Create group”.

2. Type in a name for the group, e.g. “Boundaries”
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Figure 40: Selecting a thematic query

Figure 41: Creating a display 
group



3. Drag-and-drop each display into the group, making sure you drop on top of the text, i.e. 
“Boundaries”. Start with the topmost display (“District Municipalities”) if you want to keep 
the order.

A more efficcient procedure would be to create the group before 
adding the feature classes. You can right-click on the group display 
and then click “AddN” to create displays for the selected feature 
classes inside the group. (See Figure 42).

Now that you have a group of related displays you can easily switch 
offe the displaying of the whole group by clicking on the group's eye 
icon. Thee whole group can also be dragged to a diffeerent position in 
the list. 

Thee above examples are the most typical uses of the Display manager.
Theere is, however, a more efficcient way to set up the displays of a 
view from multiple secondary maps: Design Mode.

Using Design Mode to set up your Views
A more efficcient method of adding displays into a view, is to copy the displays from another project 
to your main project. Displays are references to feature classes and contain many options and 
settiings. By copying a display, you will retain all those settiings. By adding a feature class into a view,
you create a new display which references the feature class and also the feature class' default style. 
Theerefore, if you are settiing up your own projects to utilize displays from external sources, (and 
assuming you want to preserve the general appearance and behaviour) you would save time by 
copying displays from the source project to your main project.

For the following examples you can use one or more of the
provincial cadastral maps as well as the OpenStreetMap, or one of
the projects that combine these. All the South African maps can be
downloaded from this page: 
httip://www.planetgis.co.za/browse.php?id=11

1. Activate Design Mode.

2. Expand the nodes of your project so that the displays of the
filrst view are visible (Figure 43).

3. Right-click on the view node (“My project”, if that is what you named your project).

4. Click “New”, then “Group” (Figure 44).

5. Enter “Cadastral” as the name for the group.

6. Now expand a cadastral map and click on its filrst
view. You must be able to see the displays of the
view on the right-hand side.

7. Click on the filrst display on the right-hand pane
(“Parent farms”), then press <Shift> and click on
the last display you want to use (“Parks” is a good
choice). (Figure 45).
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Figure 42: Adding feature classes 
into a group

Figure 43: Expanding a view to see its displays

Figure 44: Creating a display group in Design mode

http://www.planetgis.co.za/browse.php?id=11


8. Use the scrollbar to make your target visible in the leftw-hand pane. Your target is the group 
display you have created (“Cadastral”). (Figure 45).

9. Now drag your selected displays from the right and drop it exactly onto the text of your 
target node (i.e. “Cadastral”). Also shown on Figure 45.

You can also use Design mode to copy displays from one view to another in the same project, delete 
multiple views, move displays into a group, reorder displays, etc.

Copying displays vs. copying feature classes
It is important to be aware whether your source and target is a display or a feature class, since they 
may look the same (same styles). A display is a reference to a feature class. If the source is a display 
and you are copying into a target vie�, you copy a reference along with all the settiings of the 
source display. 

You can drag a feature class (or selection of feature classes) into a view of the same or another map. 
Theis will simply create a display referencing the source feature class. (Thee display will not have any 
custom settiings, since it is new).

If you drag a feature class to the “Feature classes” node of another map (or into a feature class 
group), a copy of the feature class with all its features and attiributes will be made. In this case you 
will have created a duplicate of the database and you will still need to create displays (drag them to a
view) to see them in the destination map.
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Figure 45: Dragging displays from one project to another



Styles (and everything else)
Styles will usually be copied across automatically, but you can always drag a style to another 
project's “Styles” node. You can also drop a style onto a feature class or a display to assign the style 
to the feature class or display. If the style is from a diffeerent project, a copy will automatically be 
made in the destination map and the reference will be to the new copy.

You can also copy style elements (e.g. a pen) to other styles.

Print frames, flooating objects and saved locations can also be copied between projects in this way. It 
will serve you well to have a project containing templates of your styles and print frames that you 
can call up and copy anything you need to a new project.
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Chapter 6

COORDINATE SYSTEMS



World Geodetic System 1984
WGS84 is the coordinate system used most commonly on Earth. It defilnes an “ellipsoidal” model that
closely approximates the shape of the earth1. Thee origin point of this system is the centre of Earth's 
mass, determined by observations from outer space to an accuracy believed to be less than 2cm.

WGS84 is a spherical coordinate system which uses angular units, latitude and longitude. It is 
important to realise that the distance between two points on the surface of the Earth is expressed as 
an angle between the two points and the centre of the Earth. Thee actual radius of the Earth 
determines the exact distance between the points and will change if a diffeerent ellipsoidal model is 
used. A latitude or longitude is simply the angle of some point on the surface, the middle of the 
Earth and the zero line of latitude (the Equator) or the zero line of longitude (the Greenwich 
Meridian).

Thee WGS84 ellipsoidal model has a major (equatorial) radius of 603780137m and a minor (polar) radius
of 603560752m. An ellipsoidal model does not take into account mountains or even mean sea level at 
any particular location. Thee model is a smooth surface which is the mean sea level for the whole 
planet. Mean sea level at specifilc locations can be up to 105m below the ellipsoid (South-East India) 
and up to 87m above (eastern Indonesia). Theis is due to gravitational changes which is due to 
irregularities in the composition of the inner Earth.

Coordinate systems and projections
Maps on computer screens and paper are float representations of a surface which is not float. Thee 
transformation from a spherical surface to a float surface is called a “projection”. If you look at the 
World map, it is obvious that the closer to the poles you get, the more the shapes and sizes of land 
masses are distorted. Theis is because the projection used keeps lines of longitude straight and 
parallel. It is common for a world map to use a diffeerent projection where lines of longitude are 
curved, but not so much on computers. 

If you zoom in a bit you will see that Planet adjusts the distance between lines of longitude 
(meridians) so that shapes of landmasses
(or borders of countries and other
features) in the middle of the screen
correspond bettier with reality. Only a thin
pixel-wide horizontal line running
through the centre of the map is exactly
correct. Everything North and South of
this line must necessarily be distorted to
keep meridians parallel to each other. Thee
more you zoom in, the more accurate
features will be refloected, similar to how
the Earth seem floattier the closer you are to
the surface.

In 1569, Gerardus Mercator, a Flemish
cartographer, presented a projection to
solve this problem for nautical navigation.
His solution was to stretch out the distances between lines of latitude (parallels) the closer they get 

1 Thee shape of the earth is an “oblate spheroid” - a sphere with a slight bulge at the equator due to the centrifugal force 
due to rotation.
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Figure 46: Thre famous Mercator projection



to the poles. Thee shapes of landmasses are distorted similarly, but this projection became the 
standard for nautical navigation because lines of constant course become straight lines. 

Other methods of projection are also used, especially
when working with smaller areas than the World map.
Thee most common projection is to use a cylinder that
touches the surface of the sphere along a line of
longitude (meridian). Theis is then floattiened into a system
with X and Y coordinates. Thee floattiening of the cylinder
creates a distortion which only becomes noticeable
about a degree away from the central meridian. Theis
type of projection is called Transverse Mercator2 and
is appropriate for areas no wider than 6 degrees
(preferably less than 3 degrees). Projections like this are
used in local coordinate systems.

Thee projection onto screen of spherical coordinates is a simple on-the-floy transformation. Thee 
coordinate system remains spherical, so it is called a “geographic coordinate system”. 

When the coordinate system is a projection onto a float surface with X and Y values (usually in 
metres) it is called a “projected coordinate system”. Since the coordinate system is on a float surface,  
there is no transformation needed when displaying on a screen or paper. Thee X and Y values in a 
projected coordinate system are typically the distances from the equator and a chosen central 
meridian.

Local coordinate systems
In South Africa there is a Transverse Mercator coordinate system centred around every odd-
numbered meridian. Theey are called “Lo” (el-oh) systems. You can see in Figure 37 (previous chapter)
that the “Hartebeesthoek94 / Lo” systems range from 15 degrees longitude to 33 degrees, spanning 
the breadth of SA. A shorter form of the name “Hartebeesthoek94 / Lo XX” (where XX denotes the 
longitude value of the central meridian) is simply “WGXX”. 

It is becoming more common to simply use a geographic coordinate system, but if your project 
requires the use of an Lo system, you need to choose the system with the central meridian (the 
number aftwer “Lo”) that runs through your area. If there are two, choose the one closest to the centre 
of your area. Sometimes it is impossible to “spill over” into a neighbouring zone. Theis is OK, it will 
be nearly impossible to notice the distortion until you get into the next neighbouring zone.

Features can also be copied between zones with no loss of information (see below).

Outside of South Africa – especially in other African countries – the coordinate system used is 
Universal Transverse Mercator (UTM). Theis is a system developed by the United States Army 
Corps of Engineers that divides the earth up into zones that are 6 degrees wide. Distortion is 
balanced out by using a scale factor which creates two lines of “true scale” parallel to the central 
meridian. Thee South African Lo systems do not use a scale factor (actually it is simply 1) and 
therefore the only line of true scale is the central meridian and that is also the reason why Lo 
“bands” are only two degrees wide.

2 Other names in use are Gauss-Krüger or Gauss conformal projection.
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South facing coordinate systems
Rather unique in the world, South Africa has “south facing” local coordinate systems. Lesotho, 
Swaziland, Namibia and Zimbabwe shares this oddity, while Botswana uses UTM like most other 
African countries.

Contrary to what a mathematician would expect, the convention in Lo systems is that X is the 
distance from the Equator toward the South Pole and Y is the distance �est of the chosen central 
meridian3. Even more confusing is that the convention is to write Y filrst, which make the 
coordinates appear like X,Y except that the signs are wrong. It is easy enough to convert Lo Y,X to 
Cartesian coordinates:

X' = -Y
Y' = -X

Also important to know is that directions are south facing: 0 degrees is South; 90 degrees is West.

All softwware that hasn't been specifilcally designed for South Africa will store coordinates in 
Cartesian format internally. Some (like Planet) will display the coordinates in the expected 
convention. Shapefilles always come in Cartesian X,Y. DXF can be either. If you receive Lo 
coordinates in a text fille (typically from a survey diagram) it is most likely Lo Y,X. If you receive 
coordinates in a database table it can be either.

Fortunately, since South Africa is far from the equator, the X value is always larger than 200000000 
which helps identifying which is which, however, it is not uncommon – especially in CAD drawings
– for the 2 000 000 to be subtracted to reduce the length of the numbers. Theis is called a “false 
northing”.

Datums in South Africa
In the simplest sense, a “geodetic datum” defilnes the location of the centre of the earth and the size 
(major and minor radius) of an ellipsoidal model of the earth. Geodetic datums usually have a filxed 
point defilned somewhere on the surface of the earth to account for continental driftw.

Hartebeesthoek94 is the officcial South African datum and uses the same centre point and dimensions
as WGS84, so a coordinate in a system based on either datum will be the same4.

Before WGS84, a diffeerent estimation of the size and centre of the Earth was used. Thee South African
coordinate systems were initially set up based on the size of the Earth as described in a book named 
“Geodesy” writtien by Col. Alexander Ross Clarke and published in 1880. He described the “filgure of 
the Earth” with a major radius of 603780249m, only 112m more than our current model for which we 
needed to get into space! Theis model of the Earth is called the “Clarke 1880 ellipsoid”5. Thee original 
South African datum was called the “Cape Datum” and has its filxed point at Buffeelsfontein, near Port
Elizabeth.

Gravity measurements from space allowed us to accurately determine the centre of Earth's mass to 
within 2cm. Thee diffeerence between the centre points of WGS84 and Cape (Clarke 1880 ellipsoid) is 
surprisingly small too: 292m north, 110m east and 134m along the axis from the centre of the Earth 
to 0, 0 on the surface (a point at sea about 500km South of the coast of Ghana).

3 Every other system in the world using X,Y coordinates follow the Cartesian convention: X-axis points East and Y-axis 
points North.

4 Well, nearly. WGS84 actually gets recalculated periodically. At the moment Hartebeesthoek94 coordinates are between
20 and 30cm away from WGS84. Continental driftw will also have an impact because the Hartebeesthoek94 datum has a 
filxed point at the Hartebeesthoek Radio Astronomy Observatory Telescope near Pretoria.

5 Oftwen called “Modifiled Clarke 1880” since Clarke calculated a diffeerent filgure in 1866 (~43m smaller).
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Maps produced in South Africa before 1999 mostly used the Cape Datum and from 1999 onward 
maps were using Hartebeesthoek94 and older data converted to the new datum. It is becoming 
increasingly rare to filnd maps in the Cape Datum, but if you have such data, it is important to know 
the diffeerence and the procedure for converting the data.

When data sources are mixed and you have features of both the Cape and Hartebeesthoek94 datums,
there will be an offeset of roughly 300m north-east in a projected coordinate system. In a geographic 
coordinate system the diffeerence is much less because the angular (spherical) coordinates assume the
same Earth radius (whichever datum is selected for your map). Thee diffeerence varies slightly 
throughout South Africa from around 5m to 15m.

Changing coordinate systems
If you know that a map is in the Cape datum, either Cape geographic or Cape Lo projected, it is a 
simple action to tell Planet about it: Click File→Project→Coordinate system to open the 
coordinate system window. 

To tell Planet what coordinate system a project is currently in click the Select buttion. To convert a 
project to a diffeerent coordinate system, filrst verify that the information about the current system is 
correct (and click Select if it isn't), then click the Convert buttion to select a new coordinate system 
and reproject all features in the project to the new system. For multi-map projects this need to be 
done for each individual map. An alternative to the File→Project→Coordinate system menu is 
to right-click on the project in Design mode and then click Coordinate system.

If you are copying features between two maps with diffeerent coordinate systems, the features will be
automatically reprojected provided the coordinate systems have been correctly defilned in both 
maps.

When working with diffeerent coordinate systems, you may want to maintain a Planet project for 
each system and periodically copy features between then (typically from the older to the newer 
system). Theat way it is easy to update features in the old system from sources that remain in the old 
system. (See Importing below).

Other projections
Theere are many other projections designed for small scale mapping (continents / subcontinents). 
Theese are primarily conical projections which model the curvature of the earth by a conic volume 
that bisects the sphere at two lines (usually) of latitude (also called “standard parallels”). 

Thee two most common projections are “Albers Equal Area” and “Lambert Conformal”. Thee former 
preserves area but distorts direction and distance, while the lattier preserves direction and angles but 
distorts area and distance. If you encounter source data in either of these projections, you will need 
to supply all the parameters for the projection exactly as the source of the data has determined them.
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Secondary (projected) coordinate system
For projects in a geographic coordinate system, Planet can also be set up with a second, projected 
coordinate system.

Figure 48 shows a geographic
coordinate system set up with an
additional projected coordinate
system. Theis is very useful for
importing or exporting features
and for coordinate display on your
map.

Map coordinate display
Thee coordinate system for the active project is shown
next to the scale and mouse cursor coordinates (Figure 
49).

To change the coordinate display format, click directly on the
coordinate text. Along with other formats for spherical coordinates,
you will also see an option to display projected coordinates (if a
project system was set up as in the previous section).

If you select “Y; X” as in Figure 50, you will see that the coordinate system text changes to 
“Hartebeesthoek94 / Lo27*”. Thee asterisk at the end indicates that it is not the actual coordinate 
system of your project.

Mixing coordinate systems
Planet will allow you to create a multi-map project containing diffeerent coordinate systems. Thee 
coordinate system that Planet will use is the one set up for the active map. Features from secondary 
maps will not be reprojected on-the-floy and features from secondary maps will not be in the correct 
position6.

6 In future, on-the-floy reprojection may be implemented.
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Figure 48: Coordinate system window with secondary coordinate system selected

Figure 49: Scale, mouse coordinates and coordinate system 
display

Figure 50: Select coordinate display format



Considerations when importing or exporting features

Importing
Before importing data that has projected (X,Y) coordinates, you need to set up the coordinate system
to match the source exactly. Shapefilles normally come with a *.prj fille which describes the source 
coordinate system. You can open this fille with Notepad. It is a bit hard to decipher since all the 
information is in one line, but it is possible.

If you have a project already in a projected (X,Y) system but are importing geographic (/spherical lat 
& long) coordinates, you don't need to do anything. Every projected coordinate system knows how 
to convert spherical coordinates to local coordinates and back. Except, if the datums are diffeerent, 
e.g. if the spherical coordinates are from a Cape datum but your project is in Hartebeesthoek94 or 
WGS84. For this scenario follow the same steps for reprojecting explained above.

Exporting
Thee issue of producing X,Y coordinates from lat,long coordinates comes up most oftwen when 
exporting to DXF. Theis is because DXF is used to get GIS data into CAD applications, which nearly 
always need a float, projected coordinate system. PlanetGIS therefore provides this reprojection as an 
option in the DXF export options window (which simply sets up a secondary coordinate system as 
shown above).

In all other cases you need to reproject your data before exporting. Thee procedure is as follows:

1. Create a new project with the desired coordinate system

2. Copy the data from the source project to the new project

3. Export the data from the new project.

Thee copy process will automatically reproject coordinates. Theere are two ways to copy data between 
projects:

1. For a selection of features on the map, use Edit→Copy

2. Drag-and-drop feature classes between projects in Design Mode
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Chapter 7

CAPTURING FEATURES



Creating a New Feature Class
Although called “feature classes” new feature classes are actually “feature subclasses”. At the top 
level, a feature class is a subclass of the root feature class. Thee root feature class contains all 
attiributes that are applicable to all features in any feature class, including the feature's location and 
geometry.

When creating many feature classes, consider whether a feature class is bettier defilned as a subclass 
of another feature class already in your project. For example, an asset management system for a 
municipality may have at the highest level “Electricity”, “Water”, “Sewer”, “Stormwater”, “Roads”, 
etc.

When adding attiributes, consider at which level an attiribute
will be most appropriate. Which feature subclasses will share
the attiribute?

Allowed feature types
When creating a new feature class, you must specify which
feature types will be allowed. In the vast majority of cases, it
is best to choose only one type to avoid future confusion and
complications with styles and capturing. It can be very
useful, though, to allow multiple types as can be seen in the
OpenStreetMap project.

You can also specify no types to force features to be captured
into subclasses instead. Thee feature class will act as a “group” in this case.

Although possible, it is not recommended to mix raster with any other type.

Capturing Points

Figure 52: Capturing a point into a new feature class

To capture a point on your map, into a new feature class, follow these steps:
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Figure 51: Allowed feature types



1. Click Edit→Capture (or <Ctrl+N>)

2. Click Ne�, then Feature class6  (or select a feature class in the tree and click Ne�, then 
Feature subclass6)

3. Enter a unique name (unique among other subclasses of the same parent class, if any)

4. Check Points in the “Allowed feature types”

5. Click Create. If using PlanetGIS Explorer, your new feature class will be placed in a group 
called “Annotations”.

6. Click Select

7. Click on the map to capture a point.

You will notice that the “click mode” has automatically changed to “Capture point”.

If you know the coordinate for the point that you
want to capture, right-click instead of leftw-clicking on
the map to enter the coordinate by hand.

Planet understands coordinates in various formats:

• Degrees:minutes:seconds (27:30:00.0)

• Degrees° minutes' seconds” (27° 30' 0.0”)

• Degrees:minutes (27:30.0)

• Degrees° minutes' (27° 30.0')

• Decimal degrees (27.5)

“S” at the end is a substitute for negative latitude (don't do -27.5 S) and similarly “W” at the end is a 
substitute for negative longitude. “E” and “N” are entirely optional.

To capture multiple points, keep clicking on the map. Each new point will be a separate feature with 
a new FeatureId.

Moving points

To move a point, you have to change the capture mode. Click on the “Capture point” buttion ( ) 

and hold the leftw mouse buttion down for ½ second (long click). Theen click the “Edit vertex” buttion (

). When moving points, you have to be extra careful not to inadvertently move a coordinate of a 

feature (eg. an administrative boundary or orthophoto). It is best to click on the point (lettiing go of 
the mouse buttion) and then to verify that you have the desired point selected. Thee Attiributes, 
Selection and Coordinate tabs on the right can be used to monitor your selection.

You will now see a small black square on top of the point feature. Now click, hold and drag the point
to the desired location and let go of the mouse buttion.

Deleting points
To delete any feature that is not desired, verify you have that particular feature selected (Info, Select 
or Edit tab on the right) and only that feature selected (unless you are deleting multiple features), 
then click Edit→Delete in the main menu.
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Figure 53: Entering a coordinate by hand



At this point you would probably want to select a new
style for the points which currently have the default
small white dot (if you haven't changed your default
style). Follow these steps:

1. Activate the Displays tab.

2. Select the “Points” display and right-click on it to
see the popup menu.

3. Click Select style6

4. Click Ne�6, then Style6

5. Enter a name for the style.

6. Click Add6, then Symbol6

7. Click on the Shape buttion.

8. Expand the “Stock” node if necessary.

9. Select “Industrial” (feel free to deviate here)

10. Select a shape.

11. Click OK

12. Change the width to 10mm and click OK.

13. Now click on Add6 and Font6

14. Change the font settiings, e.g. check “Bold” or leave
as is.

15. Click OK and again OK and filnally Select.
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Figure 55: Selecting a shape for a symbol

Figure 54: Creating and selecting a new style



To conclude this exercise, we will label the captured points.

1. Change the click mode to Tag.

2. Select a point by clicking on it.

3. Activate the Attributes tab.

4. Enter a label for the point, e.g. “Tower 1”.

5. Save the change by clicking on the Save buttion or pressing <Enter>.

6. Select the next point.

7. Enter another label and press <Enter> to save.

Capturing Lines
Repeat the steps above to capture and create a new feature class which allows lines1 instead of 
points (Edit→Capture→Ne�→Feature class6). Call the new feature class something like “My 
lines” and make sure to check the “Lines” check box. Click the “Create” and “Select” buttions to start 
capturing. Notice that the click mode has changed to “Capture” automatically. You can activate the 
Coordinates tab on the right to see your captured coordinates.

Now follow these steps:

1. Click somewhere away from the points to capture the filrst coordinate of a line.

2. Move the mouse cursor close to the centre of one of the points. Notice how the location “snaps” 
to the point when the mouse is close enough. Move the mouse around a bit to see the 
“snapping” at work similar to a sticky spot.

3. Click to capture the second coordinate exactly at the centre of the point.

4. Repeat for second point. In a GIS it is very important to capture coordinates that are supposed 
to be coincident with other coordinates carefully so that are “snapped” to be coincident.

5. Move the mouse away and right-click.

1 Strictly speaking, a line could be a line segment (exactly two vertices/coordinates) or a polyline (many 
vertices/coordinates). In PlanetGIS we use the term “line” as a shortening for “polyline”.
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Figure 56: Labelling points



6. Select End. (A quicker way if you don't want to see the menu is to press <Enter>).

Note that if you wanted to retain the coordinate at (5) you would have to have filrst leftw-clicked to 
capture the coordinate.

To remove the last captured coordinate, right-click and click Undo. To cancel capturing the feature, 
right-click and click Cancel or press <Esc>.

Lines with breaks
Lines may have multiple parts, i.e. lines can have  “gaps”. To end a line part, right-click and click 
Break. Click again to start the next part of the line.

Using distance and direction to determine subsequent coordinates
Quiite oftwen, the relative distance and direction between coordinates
is known instead of the coordinates themselves. Right-click while
capturing and click Enter direction/length.

It is sometimes useful to move the mouse in the general direction of
the anticipated next coordinate. Thee
current distance and direction will be
displayed in the window, which can then
be rounded or made accurate.

Snap options
Snap options control the exact position of a captured coordinate which 
may be up to a certain amount op pixels away from the mouse cursor 
location. Theis is called “Snap sensitivity”.
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Figure 58: Capturing by specifying distance 
and direction

Figure 59: Snap options

Figure 57: Capturing a line



When capturing features by tracing them on an underlying orthophoto, one oftwen doesn't want to 
have other features interfere with the capturing, i.e. you might want to turn snapping offe. In other 
instances you may want to snap to points (vertices/coordinates) but not the line segments 
connecting them.

Capturing Polygons
Polygons are similar to lines except that they are always closed. Polygons can have multiple “outer 
rings” and each outer ring may have any number of “interior rings” which form holes or islands. 
Click Break in the capture menu to start a new ring. If you are capturing a hole, be sure to reverse 
the direction, i.e. if the outer ring was captured clockwise, capture all holes/islands counter-
clockwise.

Polygon orientation
PlanetGIS allows polygons in any orientation, but the standard in GIS is to have outer rings in 
counter-clockwise order and inner rings in clockwise order. An observer walking around a polygon 
in the same order of the coordinates will have “surface” / filll on the leftw hand side and either nothing 
or hole / island on the right hand side. It is a good habit to be consistent with this convention.

Capturing rectangles or shapes with right angles
Planet is oftwen used to capture the footprint of buildings (or “rooftwops”). To speed up the process 
Planet has two very useful functions.

1. Complete rectangle. Capture one side and position the mouse over the next corner, then 
right-click and select “Complete rectangle”. Don't leftw-click on the third corner because the 
angle will not be guaranteed to be 90 degrees unless you use the following. Thee mouse 
position tells Planet the length of the second edge and Planet will place the third corner so 
that interior angles are 90 degrees.

2. Snap to right angle. Theis snap option will steer a captured coordinate to a location which 
will form a right angle with the previous segment. You may want to increase the snap 
sensitivity for this.

Capturing circles
To capture a circle, start by indicating the centre point and move the mouse to the edge of the circle, 
but don't leftw-click. Now right-click  and click “Draw circleN”. Thee radius as indicated by the mouse 
and central coordinate will be displayed in the Dra� circle window. You can supply an exact radius 
and change the central coordinate. Thee circle will be approximated by many line segments. Thee 
default number of segments (“steps”) is 32. Click OK to filnish capturing a circle.

Capturing Raster Images
“Raster” means a matrix or grid of values or colours. Raster images in GIS are typically satellite or 
aerial photographs, but could also be scanned drawings or maps. Most raster images will already be 
“georeferenced” meaning the location on earth is known, but they need to be captured in Planet 
similar to other types of features.

Planet supports the following types of images directly:

• MrSID (*.sid)

• Enhanced Compressed Wavelets (*.ecw)

and will create compressed and indexed images (*.ijp) from:
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• Windows Bitmaps (*.bmp)

• JPEGs (*.jpg, *.jpeg)

• TIFF and GeoTIFF (*.tif, *.tiffe)

• Portable Network Graphics (*.png)

MrSID, ECW and GeoTIFF images have their geo-location encoded within the image fille. Most 
images are accompanied by an additional small text fille, called a “world fille”. Planet will recognise 
the world fille, but if location information is embedded in the image fille, the world fille option will not
be selected automatically.

To capture a raster image, click Edit → Capture. Create a new feature class and select only “Raster”
for the allowed types. Theen click Select.

In the “Insert image” window, click Browse and select one or more images. (Please note that you can 
insert all your images in one step. Ctrl+A is an easy way to select all images in a folder or use the 
search function to list all images in all subfolders). 

World files
World filles describe the position, orientation and pixel size of images so that they can be accurately 
placed on a map. Theese filles have the same name as the image fille that they describe, but the 
extension is formed by taking the filrst and last lettier from the image fille's extension and adding a 
“w”. Thee world fille for Image001.JPG will therefore be Image001.JGW.

Planet will automatically place an image in its correct location based on an accompanying world fille 
or encoded location information. In the absence of this information, you have the option to indicate 
a diagonal line on the map or enter coordinates.

Specifying coordinates or indicating corners on your map
If you have coordinates for a diagonal (two corners separated diagonally), you can enter them 
manually by selecting “Specify coordinates”. If there is no geo-location information available, your 
only option is to indicate a diagonal line on the map. Theis will normally be a rough estimation, but 
you will be able to improve the location aftwerwards.

Once your image is captured and appears on your map, you may want to improve locational 
accuracy by indicating a shiftw (translation) as well as a stretch (scale). Theese functions are under the 
Edit menu: Translate and Scale. Planet cannot yet do rotations and other transformations on raster
images.

Labelling Features
We labelled a feature during the exercise on page 61. Every feature has a special attiribute called 
“Label” which you can edit in the Attiributes tab. As soon as you enter a value for this attiribute and 
save the change, you will see the feature labelled on the map. If you don't see a label the style used 
for rendering the feature does not include a font, or the label may have been dropped due to 
congestion on the map.

It is oftwen useful to limit the scales at which features are labelled, and sometimes at diffeerent scales 
than other drawing elements. You might want to show the outlines (pen) of an administrative 
boundary to switch on at a certain scale, but only display the label (font) at a bigger scale (zoomed in
closer) to reduce cluttier of text on your map. Another example would be to switch offe the labels 
when zoomed in too much, e.g. you don’t necessarily need to see the name of a country at a scale of 
1:5000. Figure 13 on page 25 shows a font with limits on both minimum and maximum scale.
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Fixed vs automatic labelling
Thee default labelling method of PlanetGIS is to distribute labels as evenly as possible while 
maintaining an obvious association between a feature and its label and omittiing labels that will 
appear ambiguous. In some cases this is not ideal. Property boundaries, for example, are bettier 
labelled at their centroid.

Figure 60 shows “Erven” set to display labels at the centroid of each polygon. Lines will be labelled 
at a point on the line that is exactly in the middle, measure along the line.

Placing static text on the map
Text is not a GIS “primitive” element (or in other words, a feature type). Some systems allow text, 
calling them “annotations”. In PlanetGIS2, static text can be placed on a map by labelling a point, but 
providing the display a style without a symbol and settiing the “filxed placement” option. Thee 
alignment of the font in use by the style will determine the relative position of the text to the 
(invisible) point.

Thee “Orientation” attiribute (an attiribute immediately following “Label”) is used to determine the 
rotation of the text. 0º means “upright” text, or in other words the vertical axis of a lettier points 
North. An orientation of 90º will have the vertical axis of a lettier point East. Thee degrees used for 
label orientation are geographic (compass) degrees, regardless of the coordinate system settiings, and 
refer to the vertical axis of the lettiers.

Purely static text will also have the “Allow overlap” option set. Theis way you will be guaranteed to 
see the text. Theis is obviously not what you want, in most cases, when producing output maps.

Labelling from a database
Text from another attiribute or detail table can also be used to label features. Select the source in the 
drop-down box in the Label tab of Display properties. (See Figure 60). Thee disadvantages to this 
approach is that it can be slow to display a map for the filrst time. Planet needs to load all the labels 
into memory (and keep it there) before the rendering of a map can be completed.

2 In PlanetGIS 3 and earlier, there was a feature type for text. Since version 4 the type of such feature classes is 
automatically changed to point.
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Figure 60: Label options for a display



Another disadvantage is that when changes occur in the database, Planet may not be aware of it, so 
labels need to be reloaded from the database. Re-opening the map will accomplish this, or pressing 
<Ctrl+F5> or holding <Ctrl> while clicking on the Redraw buttion.
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Chapter 8

GOOGLE EARTH



Introduction
Google Earth is a very popular application that allows one to view satellite and orthophoto images 
from anywhere in the World. Thee ability to capture ones own points, lines and polygons with 
Google Earth makes it an ideal tool to do GIS-like work with it. Google Earth is very “consumer 
oriented” and uses diffeerent terms for certain things than what a GIS professional will use. A point, 
for example is called a “place mark” and a line/polyline a “path” in GE.

To download Google Earth, go to this page: httip://www.google.com/earth/download/gep/agree.html 
and use “GEPFREE” as the license key when installing. Theis link if for Google Earth Pro, which has 
some advanced features over regular Google Earth.1 

The KML / KMZ standard
Google introduced a new text-based (XML) format for exchanging geographic information. Thee fille 
format is large (being human readable), cumbersome and somewhat un-GIS-like. However it has 
become very popular and works well with Google Earth as long as feature count is limited to at most
a few thousand. Depending on your industry, you may be encountering KML filles more oftwen than 
shapefilles.

KML filles are used to exchange features between Google Earth and Planet GIS. KMZ filles are simply 
zipped versions of KML filles. To view the content of a KMZ fille, rename it to a .ZIP and unzip. (Thee 
zip will contain a fille called “doc.kml” which can be opened with Notepad).

Troubleshooting Google Earth
All interaction with GE is through KML filles. Theere is no intra-program communication. To launch 
GE with a KML fille, Planet simply asks Windows to open the KML fille with the appropriate 
program. Theis means two things:

1. Google Earth must be installed correctly.

2. KML filles must be associated with Google Earth.

Sometimes the Windows association between KML filles are broken by other applications or 
manually. A re-installation of GE should filx the problem, alternatively you can check and repair the 
fille association by right-clicking on a .KML/.KMZ fille
in Windows' File Explorer, then click Open �ith6 
(If you don't have a .KML/.KMZ, use Planet to create
one by exporting a feature: see “Exporting KML” in
next section).

If you need to browse for the executable, Google
Earth Pro is at C:\Program Files (x86)\Google\
Google Earth Pro\client\googleearth.exe

Make sure you check “Always use the selected
program to open this kind of fille”.

You may have to repeat this process with a .KMZ fille
aftwer doing it with a .KML fille.

1 Since January 2015, Google Earth Pro is free: httip://google-latlong.blogspot.com/2015/01/google-earth-pro-is-now-
free.html

Google Earth 69

Figure 61: Checking and repairing KML fille association
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Another form of troubleshooting is to inspect the KML filles that Planet produces. When not 
explicitly exporting to a KML/KMZ fille (i.e. View→In Google Earth→...), Planet creates .KML filles 
in your system's %TEMP% folder. To see where your temporary folder is, simply type %temp% in the 
“address bar” of Windows' File Explorer. Thee filles that Planet created will look like planetxxxx.kml. 
Sort by “Date modifiled” (descending) to easily spot them at the top of the list. If you now double-
click on one of the .KML filles, that is the same as what Planet does to launch GE. (Or right-click and 
Open withN to check the association).

Interacting with Google Earth
PlanetGIS has several useful ways to interact with Google Earth (“GE”). Thee following main menu 
commands will take you directly to GE:

• Vie�→In Google Earth→Current location
Zoom to same location and approximate scale.

• Vie�→In Google Earth→Tags as placemarks
Current tags on the map are created as place marks (points).

• Vie�→In Google Earth→Selected features
Selected features are exported to GE and displayed as an overlay.

Exporting KML
• File→Export6 

Create .KML or .KMZ filles that can be used with GE.

As with other export formats, the File→Export menu item allows the creation of KML/KMZ filles 
with an options window. Theis option can be used either with one or more features selected, or if 
none are selected, you will be prompted to select one or more feature classes. First you need to enter
a name for the exported fille and select “Google Earth KML (*.kml)” or “Google Earth compressed 
KMZ (*.kmz)” in the “Save as type” drop-down list. You will then be presented with the following 
options window:
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• Export feature class as single placemark
Theis is the best way to show lots of features (many hundreds or thousands) on Google Earth 
without slowing or crashing it. Features will not be individually identifilable (clickable). Theis 
is the filrst option but not the default option. Thee default option is second because it is related
to the options further down, which are not available for the filrst option.

• Export features as identifilable placemarks
Each feature will have it's own label and if you click on one, information about that feature 
will be shown in an “attiribute balloon”.

• Display label
By default, the same label displayed in Planet will
be displayed in GE. You can also choose “None” or
a fileld from an attiribute or detail table.

• Attributes balloon
Select one or more filelds from an attiribute or
detail table to display in the attiribute balloon. See
Figure 63.

• Open in Google Earth
If checked, the KML fille (GE) will be
automatically launched.

• Hover-over highlighting
Theis creates a GE style that shows each feature
with a slight filll when the mouse is over it. While useful it may be undesirable.

Importing KML
If you have features in Google Earth (vector objects as
opposed to images; see next section for images), they can be
exported to KML and then imported into PlanetGIS. Once you
close Google Earth, everything inside “My Places” is saved on
your computer but in a location not so easy to filnd2. Since this
is all in one fille, and you have to close GE to save to that fille, a
bettier option is to right-click on the folder inside “My Places”
(or “Temporary Places”) in the “Places” tree and then click
“Save place as” (Figure 64). 

Choose a location that is easy to filnd from PlanetGIS and then
switch to PlanetGIS and click File→Import to import the KML/KMZ.

Capturing features in Google Earth
You capture features in Google Earth using the “Add Placemark”, “Add Polygon” or “Add Path” 

buttions:  

First it is a good idea to create your own “folder” for your features. Give it a name, for example, of 
“My GE features”. If you want to capture features within feature classes, you need to create another 
level “folder” for each feature class.

2 Thee fille containing everything in “My Places” is usually C:\Users\yourname\AppData\LocalLow\Google\GoogleEarth\
myplaces.kml
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Figure 63: An attrributes balloon in Google Earth

Figure 64: Saving a folder of features in Google 
Earth



Theen right-click on the new folder and click 
Add→Placemark (if you want to capture a point).  Give the
placemark/polygon/path a name and remember to move the
placemark or filnish capturing the polygon/path before closing
the properties window. 

Using Images from Google Earth
Google Earth Pro allows for images to be saved at resolutions
up to about 4800x3600. Theese images can then be captured in
PlanetGIS. If your accuracy requirements are high, you should use georeferenced orthorectifiled 
images instead.

Settring up Google Earth Pro for saving images
1. Click File → Save → Save Image (or Ctrl+Alt+S). Theis will only activate the user interface 

that allows you to save images.

2. Uncheck everything in the “Map Options” drop-down list.

3. Choose the highest or preferred resolution in the “Resolution” drop-down list.

4. Navigating on Google Earth with the mouse will cause GE to tilt the image so that the focus of 
your view is not vertical. Theis can be disabled by clicking Tools → Options... and in the 
“Navigation” tab, choose “Do not automatically tilt while zooming”. Also increase the zoom 
speed in this tab.

5. Press “R” to reset the tilt (if any) and make sure North is up.

6. Switch offe all layers (bottiom-leftw, under “Places”). You can unchecked everything by unchecking 
“Primary Database”. It is especially important to have “Terrain” unchecked since the shape of 
the surface will affeect the polygons you will be capturing in the steps below.

Steps to perform a “Google Grab”
Google Earth does not produce georeferenced images. You therefore have to position the images 
saved from GE yourself. Experience has shown the following steps to be the most efficcient:

1. In PlanetGIS, choose a viewing area for which a single image from Google Earth will be 
appropriate. 

2. Click Vie� → In Google Earth → Current location.

3. (Optional) It as advisable to maximize the GE window and keep the map area the same from this
point on. 

4. Capture a polygon to indicate the extents of the visible image:

1. Click the “Add Polygon” buttion (next to “Add Placemark”).

2. Do not close the “New polygon” window as that will end the capture process. Position it 
so that it will be in the middle of your screen (all corners of the map visible). It is not 
necessary to give the polygon a name, but it is best to give it the name of the filles you 
will be saving in the next steps, eg. “GE1”.

3. Click once in each corner of the screen. Don't try to get too close to the corner, the 
accuracy of the polygon will be increased in the next step.
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4. Click on each of the 4 vertices and drag them into the corners. If something goes wrong 
with this process, cancel the polygon and start over.

5. Click OK in the “New polygon” window.

6. You will see the polygon appear in “Places” on the leftw. Right-click on it and click Save 
Place As6

7. Save the polygon as a KMZ or KML in your working folder. Give it a name that you can 
easily identify, eg. GE1.kmz

8. Uncheck the polygon in Places so that it disappears from the map.

5. Click the “Save ImageN” buttion at the top of the map and save the image with the same name as
the polygon (eg. GE1.jpg) in your working folder. Theis will take a short while.

6. Switch to PlanetGIS.

7. Import the .kmz/.kml fille of the polygon you saved from GE: File → Import and select 
the .kml/.kmz you saved. You will now see something approximating a rectangle on your map. 
Because of coordinate system transformations and the 3D surface shape in GE, one diagonal 
(e.g. top-leftw to bottiom-right) may be more accurate than the other (e.g. bottiom-leftw to top-right).
If you are inserting multiple images, trial-and-error will provide the answer.

8. Capture the .jpg image saved from GE: Edit → Capture and create a feature class for your GE 
images if you don't have one already, otherwise select it. Theis feature class must have only 
“Raster” selected for the allowed types.

9. Browse to your GE image (e.g. GE1.jpg) and choose “Indicate on map”. Click OK.

10. Now indicate a diagonal line by clicking on one corner of the imported polygon and then a 
diagonally opposite corner. Redraw or zoom out if you don't see the image.

Additional steps to improve positional accuracy
1. Find a location on the Google Earth image where a (required) shiftw is apparent compared to 

other existing features (e.g. cadastral boundaries not aligning with visible roads/fences). Theis 
should be either an obvious point feature or a bend (vertex) on a line/polygon.

2. Make sure the GE image is selected (and nothing else). Click on it and select the GE feature class
in the Attiributes tab if necessary.

3. Click Edit → Translate and keep the default “Capture translation vector” option.

4. Click on a point on the GE image that needs to be moved to an existing feature, then click on 
the point to which it should be moved.

5. Theis specifilc point will now be considered accurate (repeat from step 1 if not). Further steps will 
investigate whether a stretch (scale) will be necessary. You will have to come back to this point 
to indicate it as “filxed” if that is the case.

6. To determine if the image also needs to be stretched (scaled), filnd a location as far away as 
possible from the point you have been focusing on where a (required) shiftw is apparent. Theis 
location needs to be diagonally separated, i.e. both along the North-South axis and the East-
West axis. Failing this, small errors may result in large errors overall. If you don't see any 
obvious discrepancies, skip the following steps.
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7. If you have identifiled a location, diagonally separated as far as possible from the initial location, 
that can be improved by an obvious shiftw to an existing feature, take careful note of it so that 
you can locate it aftwer going back to the initial point. Tip: use saved locations if these locations 
are hard to recognise visually.

8. Again make sure only the GE image is selected and then click Edit → Scale. Keep the default 
“Indicate” options for both the filxed point and the scale factor.

9. Navigate to the initial point and click on it to capture the filxed point.

10. Navigate to the second point and click once on the location that needs to be relocated, then on 
the target location.

11. Review the overall quality of positional accuracy and repeat from either step 1 or step 6 if 
necessary. Do not expect a high degree of accuracy with this method, though.
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Chapter 9

CLASSES & ATTRIBUTES



Introduction
“Attiribute” is a GIS term for an item of information about a feature or a value describing some 
characteristic of a feature. In a relational database, information is stored in “tables”. Each table 
consists of rows and columns also sometimes called records and filelds1. Each row (or record) 
contains information for a specifilc feature. Thee row must contain a FeatureId or other key fileld that 
identifiles the row as information for a specifilc feature.

Each database table typically has a diffeerent set of columns (with diffeerent names and data types). 
Theis is also called the “structure” of the table. One of the main reasons for having diffeerent feature 
classes is to have diffeerent tables with diffeerent structures assigned to the feature classes, in order to 
store information that is appropriate to each feature class.

Classes
PlanetGIS uses a much broader system of “classes” which is similar to the concept of classes from 
Object Oriented Programming (OOP). OOP is the dominant style of modern programming languages
(examples include C++, C#, Java and many others). Thee concept of a “class” here, in addition to 
simple classifilcation of data objects, includes “inheritance” where a “sub-class” inherits (also oftwen 
known as extends) the data defilnitions (attiributes) from higher level classes.

In addition to Feature classes, PlanetGIS also has Component classes, Action classes, Table classes and 
Attrachment classes. Theese can be considered “root classes” which all other classes extend by adding 
attiributes that are appropriate for entities that are classifiled into those classes. In Planet, these are 
referred to as “class types” since the actual root of all classes is a class called “Entities”.

An “object” in OOP is the instance of a class, or in other words a set of data values describing some 
identifilable entity according to the specifilcation of the class. An object, or rather the values 
describing the object is stored as a row in a table or multiple tables. Recall that we are using 
computer models to describe real-world objects or concepts (Chapter 1). Thee computer model or 
“data object” is called an “entity” in PlanetGIS.

Entities
An entity is a data object that can be identifiled by a unique number (EntityId) and is classifiled into a 
sub-class of one of the 5 “root classes” (class types):

• Feature. An entity with a location or geometry.

• Component. An entity without location (or perhaps its location is deemed to not be 
worthwhile to be determined or stored in the context of the project).

• Action. An entity that describes an event, for example an inspection.

• Attachment. Data objects used to describe or document other entities, for example 
photographs.

• Ro�. Additional data objects in tabular format, such that each “row” is an entity.

All entities have the following information stored in the database:

• EntityId. A number that uniquely identifiles an entity.

• ClassId. A number specifying the class of an entity.

1 A “fileld”, more accurately, is the space provided to display or enter a value, for example in a form.
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• ParentId. Thee EntityId of another entity that encapsulates or owns an entity, at least for 
purposes of data organization.

• Key. An additional means of identifying an entity.

• Track. An additional means of partitioning entities of the same class, mostly used to 
indicate deleted entities, or private or work-in-progress entities.

• UserId. Identifiles the last user to make changes to an entity.

• Timestamp. Thee date and time of the last change made to an entity.

• Attributes. All other values needed to describe an entity, as specifiled by its class.

Every object (set of values, each describing a diffeerent characteristic/property) in PlanetGIS is an 
entity. Classes are also entities and so are styles, displays, views, etc. though these are referred to as 
“schema objects” with the main distinction that they belong to predetermined classes and have no 
user-defilnable attiributes. Like any object, they do have values that describe characteristics (also 
called “members” in OOP) but since these values are filxed (hard-coded in the softwware) we will refer 
to them as properties, not attiributes. 

Attrributes
Thee term “attiribute” is used in two contexts: 

1. First as described above, an item of information corresponding to a fileld in a form or a cell in
a table/spreadsheet;

2. Second as the defilnition of data items that apply to all entities of a particular class – the 
names and types of data items that can be stored for entities belonging to a class.

When not referring to an actual piece of information, a value stored to describe some characteristic 
of an entity, “attiribute” needs to be understood as a defilnition or description of the data item, not the
data values. Put diffeerently, an entity has a set of attiributes (values stored in the database) and a class
has a set of attiributes (defilnitions of what can be stored in the database). In order to avoid ambiguity,
this guide will use “attiribute defilnition” to clearly indicate that the second context of the term 
applies.

Each class has a set of attrribute defilnitions that are appropriate for entities placed/classifiled into such
class or any sub-class. Care must be taken to defilne attiributes at the appropriate level in the class 
hierarchy so that sub-classes do not contain the same attiribute defilnitions as other sub-classes 
belonging to the same super-class, which in this guide will be called a parent class. An entity placed 
into a class will have the storage space (in the database) and input filelds (on screen) as defilned by 
the attiributes of its assigned class and all parent classes, but not any sub-class (child class) of the 
class to which the entity has been assigned.
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Attrribute definitions

Attiribute defilnitions are managed by selecting a class in Design mode ( ) and activating the 

Attributes tab. Click on an existing attiribute to view or modify it or click the Ne� buttion to start 
specifying a new attiribute.

Attrribute name
An attiribute’s name corresponds to the name of the column of the table in which the attiribute’s 
values are stored. Thee name may contain spaces, although most database administrators prefer 
underscores (_). Avoid special characters, especially the period (.). Commas (,) ampersands (&) and 
most special characters are allowed, but they make it more difficcult to export information to other 
database systems. Keep attiribute names as short as possible while trying to make the purpose of the 
attiribute as clear as possible. Theere is no limit to the length of an attiribute’s name.

Data type
Thee data type of an attiribute is a combination of an instruction on how to store values and how to 
display values or validate entered values. Internally, values are stored using only 4 storage classes 
(INTEGER, FLOAT, TEXT or BLOB)2.

• Integer – whole numbers; signed 64 bit integer with a range of -9,223,372,036,854,775,808 to
+9,223,372,036,854,775,807.

• Float – flooating point numbers; IEEE 754 64 bit double precision with a range of 10-308 to 
10308, with 15 decimal digits precision.

• Text – Character string of unlimited length; UTF-8.

• BLOB – Binary Large Object of unlimited size.

2 Actually a filftwh storage class, NUMERIC, will store numbers without fractions as Integers, otherwise Float and NULL 
values are technically a separate storage class. All the date types use NUMERIC.

Classes & Attiributes 79

Figure 66: Attrributes of feature class "Countries"



• Boolean – True or False stored as 1 or 0.

• DateTime – Date and time stored internally as a flooating point Julian Day number3.

• Date – Date stored internally as an integer Julian Day number.

• Time – Time of day or fractional number of days, stored as a flooating point number where 1
means 24 hours.

• UnixDate – Date and time stored as the number of seconds elapsed since the start of the 
“Unix Epoch” – 1970/01/01 00:00:00. Normally stored as an Integer, but times containing 
fractional seconds will be stored as a flooating point number.

• UnixTime – Same as UnixDate except meant to display either time only or a span of time in
days, hours, minutes and seconds.

• Any – Data is stored and displayed as-is: Integer if possible, Float if fractional number, Text 
otherwise.

Required fields & NULL values
PlanetGIS will refuse to store a set of attiributes (e.g. a form or the content of the Attiributes tab) if 
one or more attiributes have the “Required” option set and no value was entered by the user.

At the database level, such columns will have what is known as a “NOT NULL constraint”, but 
PlanetGIS uses the required floag to validate input filelds before sending values to the database to 
avoid a database error message due to a violation of a NOT NULL constraint. It is also possible to 
have the “required” floag set on attiributes which use columns without such constraint.

Contrary to standard database theory where NULL means “unknown”, Planet takes a more practical 
approach and stores all “blank” values as NULLs. (At the database level empty text is a known value 
and therefore not a NULL, but it is impractical and non-intuitive for most users to make a visual 
distinction on a computer screen between empty/blank text and a NULL value. Furthermore 
“required” in Planet means blank text is not acceptable while blank text (empty string or ‘’) does 
satisfy a NOT NULL constraint in the database).

Maximum length
Thee database engine used by PlanetGIS (SQLite) does not have the concept of a maximum length for 
data values. Thee “Max length” specifilcation for attiributes will be used to limit the length of text 
when a user enters values but is irrelevant at the database level, for example when data is imported 
from other systems.

Lookup list
Each attiribute can have a lookup list to aid in selecting values from a “pick list” or limit the possible 
values that can be entered. More on lookup lists later in this chapter.

Display label
While it is preferable to keep attiribute (and therefore column) names as short as possible4, it may be 
necessary to provide a longer label for an attiribute in an input form in order to clearly state the 
attiribute’s purpose. Thee Display label – if present – overrides the name of an attiribute in situations 
where space is available.

3 A Julian Day number is the number of days since noon in Greenwich on November 24, 4714 B.C. according to the 
proleptic Gregorian calendar. Thee fractional part determines the time, 0 being noon and +0.5 midnight.

4 For the sake of those who need to type out the names in SQL scripts when doing data analysis or manipulation.
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Units
Units can be defilned separately from a display label so that they may be appended to values in a 
report or appended to a display label or attiribute name as appropriate for the situation.

Comments
Comments are notes about the use, meaning or purpose of an attiribute and is intended only for 
persons working with the structure/design of the database.

The Attrributes tab

To see the attiributes of a feature, activate Tag mode ( ) and click on a

feature. Using the World Map, click on Cape Town and expand the 
Attributes tab by clicking on it. Figure 67 shows the Attiributes tab with the
Cape Town “Places” feature selected.

Thee top part of the Attiributes tab shows the feature class (“Places”) that has
been tagged on the map and also feature classes of underlying features which
you may have intended to select. To view attiributes of the country instead,
click on “Countries”.

Next is the FeatureId. If more than one feature has been selected, the drop-
down list needs to be used to see the attiributes of individual features.

Next is a tool bar with buttions to save changes, cancel changes, “tabular
view” and other tools. 

Thee rest of the Attiributes tab shows all attiributes of the selected feature. You
can change any value by clicking in the white box and typing a value.

Tip: To extract the attiributes for use in another application, click “Tabular
view” in the toolbar; then right-click on the data sheet and click “All rows”
followed by “Copy to clipboard' or “Open as spreadsheet”.

Note also the “Information” nodes at the top. Theese are detail tables set up to
take you to Wikipedia for more information. Click on the hyper-linked
attiribute name to go to Wikipedia.

Common attrributes of features
Now use the scrollbar to scroll to the bottiom-most attiribute. Thee last 10
attiributes are common to all features (i.e. they belong to the root feature
class). Theese are:

• Easting, Northing, Altitude
Coordinate of point, centroid of line or polygon.

• Measure
Any numerical measurement associated with the feature.

• Label
Text to display on the map.

• Orientation
Point features can have an orientation: 0 degrees is North, 90° is East.
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• Geometry
Theis is a BLOB (Binary Large Object) fileld containing the geometry (all coordinates) of the 
feature.

• Length
Length of a line feature; perimeter of a polygon in coordinate system units (usually metres).

• Area
Surface area of polygon in square coordinate system units (usually sqm).

• Key1
User defilned identifiler for the feature, can be a number or text. (More keys may be added if 
needed).

Multiple selections

To clear your selection, click Clear tags ( ), second last buttion on the leftw).

Check that you are still in Tag mode and note the hint at the bottiom of the screen when the mouse 
cursor is over the map. Thee hint instructs, among other things “Ctrl+click multi-selects”. If you hold 
down the [Ctrl] buttion you will also see that the mouse cursor changes to include a plus (+) sign. 
Now click on Saldanha, Vanhynsdorp and Springbok while keeping the [Ctrl] buttion pressed. (You 
may have to zoom in to the west coast if they are not visible).

Figure 68 shows the multiple selection. Note the correspondence between the FeatureIds in the 
yellow tags on the map and the FeatureIds in the drop-down list in the Attiributes tab. 

Notice how some attiributes appear with a black font and some with a grey font. Attiribute values 
appearing in black are the same for all selected features, while attiribute values appearing in grey are 
diffeerent.

Select a FeatureId in the drop-down list to see the attiributes of only one feature. (All attiributes will 
appear black). Now change any attiribute, e.g. “scalerank” to a diffeerent value. Thee fileld area will turn 
yellow to alert you that the value has changed and needs to be saved. Thee Post changes buttion 
(check mark buttion in the toolbar) will save the change(s) to the database.

Multi-feature attrribute capture
A very useful function of Planet is to capture the
same attiribute for multiple features simultaneously.

Select “All records” again for the FeatureId and
change any value. Thee fileld area will now turn red,
alerting you that multiple records will be updated
in the database if you save the changes.

Clicking on any of the grey values will assume that
value for all features (unless you change it). Theis is
most useful when you have one feature with data
and then select other features with no data, but you
know that certain attiributes are the same. A single
click on all attiribute values that must be the same
for all selected features (and the Save buttion) and
you have captured data for all selected features
without attiributes.
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Only changes are posted to the database. Attiribute filelds coloured yellow or red will be updated in 
the database. Fields with a white background will remain untouched.

.

Lookup lists
Lookup lists (oftwen called “lookup tables”) are used to pick values from a list instead of entering them
by hand. Lookup lists can reduce input errors and restrict input values to a predefilned set.  To defilne 

your own lookup lists, activate the Database Manager ( ) and select the database connection of 

your project. For a database connection, the filrst tab will be “Lookup lists”.

Right-click in the Lookup lists box and select Ne� list, then enter a name. If you have many 
lookup lists, create lists with sub-lists. Figure 69 shows a project with many lookup lists, organized 
into sub-lists.

With a list selected, you can enter values in the Display value box and click on the Add buttion. If 
you already have the values in a word processor (or Notepad) you can copy them to the clipboard 
and paste them with the Paste buttion. (Values need to be one per line).

If you want users to be able to add new values while capturing information, check Allo� ne� 
values. If you want to discontinue using a list, check Hide list. Theis ensures that any existing 
attiributes using the list can still filnd it.

Tip: to copy lookup lists, or even groups of lists, to another project, simply drag them onto the 
database connection of another opened project.

A lookup item has a unique ID (unique inside the project database) that will be stored if the lookup 
is used with an Integer column. Lookups on Text columns will cause the display value to be stored5.

5 Some database administrators may frown upon storing text instead of an Id, but in the real world this is common and 
it may simplify things. Storing an Id saves space and allows for the display values to be changed easily, but 
inadvertently deleting a lookup list will cause data loss. You also cannot copy tables containing lookup Ids to other 
projects, unless you are certain that the projects have identical sets of lookup lists.
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Attraching a lookup list to an attrribute

Thee easiest way to attiach a lookup list to a column (attiribute) is to

use Design mode ( ), click on the feature class and then the 

Attributes tab. Theen, next to the fileld for which you want to assign
a lookup list (and in the column for “Lookup table”), right-click to
select the lookup list.

Now click on a country and you will see a dropdown list for the
“type” attiribute in the Attiributes tab. (See Figure 71).

You can also attiach a lookup list in the Database Manager. Locate
the feature class' attiribute table (starts with f_; expand the “f” node)
and click on the Structure tab.  
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Popup Info

An alternative to using the Attiributes tab on the right, is to use the “Info” click mode ( ) instead of

“Tag”. Theis provides more space for attiribute information and may be a good alternative when using 
multiple monitors.

Multi-media content

Linking content to regular attrribute fields
Any computer fille can be linked as an attiribute. When the fille resides on the same storage media 
(“drive”) as the Planet project, a relative path should be stored to keep the link portable. If the fille is 
on a diffeerent drive, on a network location, or the Internet, the link will have to be absolute and the 
fille will only be accessible if the media is connected.

If you want to link filles to a project and be able to redistribute them together with your Planet 
project, it is best to keep such filles in a subdirectory inside the directory (or “folder”) where the 
PlanetGIS project filles reside.

To link such a fille to a feature, you can simply enter the (relative, if possible) path to the fille as a text
attiribute. For example, if you have survey diagrams for property boundaries, you would create a 
subdirectory called “Diagrams” inside your project directory and then enter a relative path as a text 
attiribute. If the fille is named 0004ZX02.TIF, (and inside a “Diagrams” subdirectory) you would enter 
the link as “Diagrams\0004ZX02.TIF”. Once you save the attiribute, you will see that the name of the 
attiribute becomes hyperlinked (blue and underlined). You can now click on the hyperlink to open 
the fille with the default application set up on your system for viewing filles of that type. It is your 
own responsibility to ensure that filles of the type that you are linking (filles with the same extension)
can be opened on your computer. In other words, you must be able to double-click on it in Windows'
File Explorer (or the desktop) and an appropriate application must then be launched by Windows to 
view the fille.
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Thee completely correct way to enter a relative path to a fille into a subdirectory is to start the path 
with a .\ (dot backslash). A single dot means current directory, and a double dot the parent 
directory. So, if for example the “Diagrams” directory (or folder, if you preferN) was outside of your 
project directory and on the same level, the relative path would be “..\Diagrams\0004ZX02.TIF”. 
Starting the relative path with a .\ also gives Planet an indication that the attiribute is a path to a 
fille. Planet recognises common fille types, e.g. .doc, .jpg, .xls, .pdf, etc. but to be completely explicit 
that an attiribute is a link to a fille, and especially if the fille is also not relative, you need to prefilx it 
with “fille://”. So in the above example, “fille://./Diagrams/0004ZX02.TIF”. (Notice how my word 
processor automatically “hyperlinked” it?)

Now that you know how it works, there is an easy way capture links to filles on your computer or 
your network: drag them from Windows' File Explorer and drop them onto an attiribute fileld. You'll 
need to place File Explorer and Planet side-by-side, or use a second screen. (See Figure 73).

Instead of a fille, you can also link to an entire folder. If a folder is linked Planet will open File 
Explorer to show the contents of the folder.

Multiple links are also possible: select more than one fille and drop them onto a text attiribute fileld. 
Thee only caveat with this is that the hyperlink will open them all at once – not suitable for more 
than a handful links.

Lastly, you can also link to content on the Internet. “www.planetgis.co.za” will take you to the 
PlanetGIS website. Remember to save the attiribute, you will see the hyperlink aftwer saving. Thee 
“www.” tells Planet (and Windows) that it is an Internet link, but some web pages do not start with 
www. Thee best way to link to a website is to start with “httip://”. Documents

PlanetGIS 5 has a built-in document manager for a much more structured method to link documents 

to features. Thee document manager resides in the “Documents” tab ( ). To add a document, expand 
the Documents tab and right-click on the white space (or existing document thumbnail). You need to
have at least one feature selected.

Theen click Add and you will be presented with the diffeerent options for adding or linking 
documents.

• Store document(s) in database
Theis is the recommended option unless database size is an issue or documents are accessed 
from a central server.
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• Link to document location(s)
Similar to linking documents in the previous section, but still bettier for multiple links.

• Link to folder
Also similar to the previous section, but bettier for multiple links.

• Link to document already in database
Search the database for documents already stored.

Thee Bro�se buttion allows you to select any number of documents
accessible to your system and the Search buttion allows for searching
of documents of a specifiled type.

When storing a document in the database, Planet will not store a
duplicate if the document is already in the database, but instead only
create a link between the selected feature and the existing document. It
is therefore safe to use the filrst option even you intend to link to an
existing document.

To see or capture metadata for a document, click on the thumbnail. To
open the document, click on the thumbnail in the information window.

Attrributes tab vs documents tab
Documents can also be linked or viewed in the Attiributes tab. (Right-
click on a feature class to add documents and photographs). Thee
Documents tab is more convenient for looking at documents of a
multi-feature selection. In the Attiributes tab, you need to navigate to a
specifilc feature (or other type of) class.

Thee Documents tab also provides fillters: feature class, component class,
tags and date. Thee date fillter is especially useful when you want to look
at documents created/modifiled in a certain year, with the option to
drill down to a specifilc month.

Tagging
Documents (and photographs) can be tagged to create a hierarchical
(directory) structure. Use the “Tags” attiribute fileld of documents to
store tags. To create sub-levels use the backslash character (“\”). For example, you might tag one 
document as “Applications\Pending” and another as “Applications\Approved”. 

You can also use multiple tags separated by a comma (“,”) to have a document appear in multiple 
“nodes” of your tag structure.

When importing a whole directory and subdirectory of documents (using the Search buttion when 
adding documents) you have the option to store the directory names as tags. Theis is a handy way to 
retain the original structure of your documents.

Use the Tags fillter (fourth buttion at the top of the Documents tab) to see the tag structure and to 
fillter to specifilc node.
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Photographs
Photographs & sketches are another form of attiributes. Activate the Photos tab
and right-click on the white-space to add a photograph. (Theis can only be done
when a single feature is selected). You can load any number of photographs for a
feature and they will be displayed as thumbnails. Click on a thumbnail to view the
original size image.

Use the mouse wheel or click to zoom in (right-click to zoom out) and drag the
mouse to pan (if zoomed in). Use the up and down arrows on the keyboard (or 
PgUp and PgDn) to view the previous or next image.

If the photographs were taken by a camera with a gravity sensor (most smart
phones), Planet will rotate the photographs so that the correct edge is “up”. If this
information is not available inside the JPEG, you can manually rotate photographs
by right-clicking on them.

You can also right-click → Copy to get the full resolution image on the clipboard,
for pasting into another application or right-click → Save asN or PrintN to launch
Windows' “Print Pictures” application.

When viewing the full resolution image, you can also adjust the brightness and
contrast (last buttion next to Print, Copy and Save to fille). You can also leave the
full resolution image open and open other photographs for comparison or capture
attiribute information for the selected feature. (Move the photograph window
away to keep interacting with PlanetGIS). Theis is most useful when using multiple monitors and 
when capturing information which is being interpreted from a photograph.

PlanetGIS can also display panoramic images which are projected onto the inside of a three-
dimensional sphere. Theese images are typically produced by specialized hardware on a tripod or 
stitched together from multiple images. Currently, any image with a width of twice or more than its 
height is assumed to be a panorama image.

Sketches
You can create your own freehand and line drawings in the Sketch tab. Theis function is especially 
useful on a hand-held device with a stylus. Figure 76 shows the sketch drawing functions.
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Detail tables
Detail tables are another way to connect information to features. Thee name “Detail” is because of the
concept of a master-detail relation in relational databases. A Detail table has an (indexed) 
column/fileld with values that correspond to values in a column/fileld6 of a master table (“key”).

Attiribute tables always have a FeatureId as the primary key. Theis means that an attiribute table 
contains only one row of information for each feature7. Detail tables, on the other hand, may contain
multiple rows for each feature, if allowed when creating the detail table link.

Detail tables can be connected to any attiribute (which makes that attiribute a “key”), but typically 
this is either the FeatureId column or the Key1 column. When using FeatureId, keep in mind that 
FeatureIds can change, for example when re-importing features or copying them to a diffeerent 
feature class.

Detail tables are used in the following situations:

• Linking to information in tables other than attiribute tables

• Linking to tables with multiple rows of information per feature

• Linking to tables in an external database

• To use SQL to present information (e.g. the Wikipedia link of countries in the World map)

• To add additional levels of master-detail relations (a detail table becomes another’s master)

Creating a detail table
When you “create” a detail table in PlanetGIS, you are actually only creating a link to a table. If the 
table is inside Planet’s database you will have had to create or import the table in the Database 
Manager (see below). Use Design Mode to create a detail table (link). Expand “Feature classes” and 
expand a feature class to right-click on the “Detail tables” node, then click Ne� or right-click on the 
feature class and click Ne�→Detail table.

If the table is internal to your project, you only have to select the table from the drop-down list in 
the filrst tab. For external tables, see Connecting to databases.

In the second (“Master-detail”) tab, you need to select a master column (e.g. features.FeatureId or 
features.Key1) and an index column for the table you are linking. If you don’t see any columns when
selecting the index, an index needs to be created. (See next section).

Change “One-to-one” to “One-to-many” if you expect more than one row to be linked to a feature.

Creating an empty detail table
If you are starting with no data, create a detail table by right-clicking on your project’s database 
connection in the Database Manager, then click Create table6

6 In relational database theory, a table is a matrix of columns and rows. However, it is common to refer to these as 
records and filelds. While record and row might be the same, a fileld is really the intersection of the row and column (or
a cell). To this author, filelds and records are more appropriate when referring to the spaces in a user interface for 
entering or viewing the content of a table, while column & row is more abstract and relates bettier to describing a 
table. httip://dba.stackexchange.com/questions/310805/what-is-the-diffeerence-between-a-record-and-a-row-in-sql-server
To complicate things further, in GIS an attiribute is a cell/fileld value, but when thinking about the structure of a table 
(e.g. adding an attiribute/column/fileld) you are really referring to the existence of the whole column, not adding any 
data.

7 Specialized attiribute tables start with “f_” while the main attiribute table is “features”. f_ tables can have zero rows if a 
feature doesn’t have any specialized attiribute information.
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Enter a name for your table. Thee
convention in Planet is to use lower-
case lettiers and underscores, but for
detail tables it is a good idea to
capitalize the filrst lettier so that it
appears at the top of table selection
lists. It is a good way to distinguish
tables you created/imported yourself
from tables that were created by
Planet. You can use spaces in table
names (and columns) if you want.
Thee convention in Planet for column
names is to use CamelCase and no
spaces.

For any changes to be allowed on a
detail table, it must have a primary
key. In Figure 77, the filrst column is
type “Integer” and “Primary key” is
checked. Click Add to start the list of
column defilnitions. Theis filrst column will simply contain numbers starting at 1 and incrementing for
each row. Theis value will not be of much interest to us, but is needed for making changes to the 
table.

Now add columns to contain your
own information, but start with the
column that will be used to link the
information to features. In this
example (using the World map), we
add a column named “CountryCode”
of type “Text”. It is important to
uncheck “Primary key” before
adding, but for this column we need
to create an index, so click “Indexed”
instead. Before adding the next
column (“VisitDate” of type
“DateTime”), be sure to uncheck
“Indexed”. Thee last column in our
example is “VisitDuration” of type
“Integer”). (See Figure 5). Now click 
Execute.

Now this table needs to be linked to the Countries feature class as described above. In the “General” 
tab, select the table “Visits_to_country” as the “Existing dataset” and select values as shown in
Figure 79 for the “Master-detail” tab.
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Figure 77: Creating a new table

Figure 78: Adding columns



Figure 79: Detail table master-detail relation

Now go to Map mode and click on a country to test the detail table. To capture a visit, select a date 
for VisitDate and enter a number of days for VisitDuration. It is not necessary to enter the Id or 
CountryCode as Planet will do that for you.

Importing a detail table
To get non-spatial data into your project there are 3 options:

• Comma Separated Values (CSV)

• dBase (DBF)

• SQL connection

Thee filrst two options are normally spreadsheet data. If you have information in an Excel (or Calc, 
etc.) spreadsheet, make sure the filrst row contains column names8 and then Save as a “Comma 
Separated Values” (.CSV) fille. (Make sure you save changes to the spreadsheet to the native format 
filrst (e.g. .xlsx, .ods) and multiple sheets will have to be saved as separate CSVs). It is also important 
to close the spreadsheet because the spreadsheet softwware will lock the fille aftwer Save as. If your 
spreadsheet softwware has a “Save a CopyN” facility, you don’t need to close the spreadsheet.

In the Database Manager, right-click on the database connection for your project and click 
Import→CSV6 and browse for the .CSV fille with the ellipsis buttion. 

8 Also check for empty rows, sub-totals and totals when converting a spreadsheet to a CSV fille. Theose could cause 
trouble.
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Figure 80: Entering data into a detail table



As an exercise, you can download GDP data from the World Bank’s website: 
httip://data.worldbank.org/indicator/NY.GDP.MKTP.CD   Theere is a CSV and an Excel version, but 
the filrst row does not contain column names, so you might as well download the Excel sheet. Go to 
the filrst (“Data”) tab and delete the filrst 3 rows. Theen Save as, or Save a Copy to a CSV fille taking 
note of the location. In Planet, select the CSV fille in the “CSV import options” screen.

Figure 81 shows the CSV import options window. If you don’t see the columns as a list (but all 
together as a single item) it means you need to change the delimiter character, most likely to a semi-
colon. You can also click the Vie� content6 buttion to make sure that Planet is interpreting the 
CSV correctly. Click on all to select all the columns and change the table name to “Country_GDP” 
(the current name, while it will work, is VERY database-unfriendly). 

Thee next step is to create an index on the column “Country Code”. You can right-click on the table 
on the leftw and select Alter table... or click on the “Structure” tab, then right-click on one of the 
column defilnitions and select Restructure table... Theen select the “Country Code” fileld and check 
Indexed, click the Update buttion and click Execute. See Figure 82.
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Figure 81: Importing a CSV
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Now you can link this detail table to the “Countries” feature class. Go to Design Mode and locate the
Countries feature class. Expand the node and right-click on “Detail tables”, then click Ne�. Enter 
“GDP” for the detail table description and select “Country_GDP” for “Existing dataset”. In the 
“Master-detail” tab, select columns as shown in Figure 83.

Now go back to the map and click on a country. In the Attiributes tab you will see GDP information.
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Figure 82: Creating an index on a detail table

Figure 83: Settring up a link to a detail table



Notes
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Chapter 10

IMPORTING AND EXPORTING 
INFORMATION



Introduction
PlanetGIS can import and export spatial and attiribute information from and to many formats. When 
importing and exporting spatial data (features), care must be taken to set up the correct coordinate 
system before importing and possibly convert the coordinate system before exporting. If the source 
or target is geographic coordinates (latitude & longitude), this is normally not an issue as long as the
datum stays the same (normally WGS84). Projected (local) coordinate systems can always convert 
coordinates to and from latitude & longitude (of the same datum). See Chapter 4 for more 
information on coordinate systems.

Theere are three diffeerent paths for importing and exporting information:

• GIS exchange filles – physical filles containing geometries and (sometimes) attiributes.

• Geo-databases – a database fille or SQL connection to a server with tables containing 
coordinates or geometries.

• Spreadsheets (CSV filles) – information can be opened immediately in a spreadsheet or 
placed on the clipboard.

Earlier versions of PlanetGIS could open many exchange filles directly by creating a temporary 
project and importing them. More recent versions of PlanetGIS requires a project to be created filrst 
(and a matching coordinate system selected) into which exchange filles can be imported.

To import an exchange fille, click File → Import and browse to select the fille. Depending on the 
type of exchange fille, diffeerent options windows will be presented as discussed below. You can also 
right-click on the Feature classes node or on a specifilc feature class in Design to import exchange 
filles.

To export an exchange fille, filrst make sure you have one or more features selected, or if you want to 
export entire feature classes then make sure that nothing is selected on the map. Theen click File → 
Export and select a fille type and destination. If nothing was selected on the map, you will filrst be 
prompted to select one or more feature classes. You can also right-click on a feature class in Design 
or on a display in the Displays tab to export to an exchange fille.

ESRI™ shapefiles 
A “shapefille” is a format of spatial and attiribute data exchange, introduced by ArcView 2 in the early
90's. Shapefilles are the most commonly used format for exchanging GIS information.

A shapefille is actually a collection of filles with the same name, but diffeerent extensions and stored in
the same directory. Theere can be around 10 diffeerent filles, of which 3 are mandatory:

• .shp – feature geometries

• .shx – index for the .shp

• .dbf – attiributes in dBase IV format1

From now on, “shapefille” will refer to all three. PlanetGIS ignores any other filles, and is able to open 
a .shp without the other two mandatory filles present. 

A fourth fille with a .prj extension is starting to become mandatory in practice. Theis is a text fille 
containing the coordinate system parameters and is useful in determining the shapefille's coordinate 
system. If this fille starts with GEOGCS["GCS_WGS_1984"… then the shapefille contains geographic 

1 One of the biggest drawbacks to shapefilles is the storage of attiribute data in dBase IV format, which among other 
limitations, limits fileld names to 10 characters.
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coordinates (latitude & longitude) and can be imported into either a geographic or projected 
coordinate system that is based on WGS84 (eg. Hartebeesthoek94). If this fille starts with GEOGCS but 
a diffeerent datum, you must ensure the datum of your project is the same or equivalent before 
importing the shapefille. If this fille starts with PROJCS, that will be followed by the name of the 
coordinate system and it must be the same or equivalent to the PlanetGIS project's coordinate 
system before you import.

Importing a shapefile
1. Click File → Import and browse to filnd one or more shapefilles (you can select many shapefilles

at once).

2. An options window will be presented for each shapefille selected. Importing will only start once 
all the options windows have been dismissed. Theis allows for unattiended operation of lengthy 
imports. In most cases, the filrst decision to be made for each shapefille is the attiribute fileld to 
choose for labelling features.
Thee filrst step, therefore, is to
click on the Preview tab in
order to see the content of the
.dbf

3. Figure 84 shows that one of
the columns, “name” is likely
the best choice for the feature
label.

4. Now go back to the Source tab
and select “name” for the label.

5. Thee orientation values are 
for rotated text, where the 
rotation angle is specifiled 
as an attiribute.

6. Also use the Preview tab to
decide which attiributes to 
import, or simply click all.

7. Thee actions tab will be 
discussed later in this 
chapter. For filrst-time 
imports, it is not necessary 
to change anything. 

8. Now click Import. If multiple shapefilles were selected, repeat from step 3.
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Figure 84: Previewing the .dbf of "a shapefille"

Figure 85: Selecting a label and attrributes for shapefille import



Exporting a shapefile
1. To export a shapefille, click File → Export. If there are no features selected on the map, Planet 

will ask you to select one or more feature classes to export.

2. Browse to a directory where the shapefille will be created. Planet automatically gives the 
shapefille the name of the selected feature class, but you can change it if necessary. 

3. A shapefille options window will be presented for each feature class to be exported. In this 
window you can change the name of the shapefille, select which attiributes to export and specify 
a detail table which filelds will be added to the attiributes.

4. If your map selection contains multiple feature classes or you have chosen more than one 
feature class,  successive options windows will be presented for each. Planet will not ask you to 
specify the location and name of each with the Windows “browse” function, but you can change
the name of each in the options window, or click on the N buttion to use the browse function.

5. Finally, if you are exporting a feature class containing multiple types, Planet will create 
additional shapefilles for each type and append “_points”, “_lines” or “_polygons” as appropriate,
since shapefilles can only store one type of feature in each fille.

Additional ways to export shapefilles are to right-click on a display in the Displays tab or on a 
feature class in Design.

Google Earth™ KML/KMZ
Many people are using Google Earth as a GIS. In some cases it can be convenient to capture features 
in Google Earth and then import them into Planet. In many cases Google Earth is an excellent way 
for people to visualize a small number of features without needing GIS softwware. For this reason, 
KML/KMZ is becoming more and more prevalent and will perhaps one day surpass shapefilles. See 
the chapter on Google Earth starting on page 68 for more detail on using Google Earth.

Instructions for importing and exporting KML/KMZ are on page 70.

AutoCAD™ DXF
A GIS needs to be able to exchange information with CAD (Computer Aided Design) systems. Most 
CAD systems have become “GIS aware” and in many cases shapefilles can (or should) be used. DXF is
a standard of exchange for CAD systems that’s been around for a very long time. Thee DXF format 
has also evolved since its inception and there are many diffeerent versions. Thee format that Planet 
understands (and produces) best is called “AutoCAD R12”.

DWG (“Drawing” files)
AutoCAD (and some other systems) stores drawings in DWG or other formats. PlanetGIS cannot 
read or produce DWG filles directly. DXF was the format intended for data exchange. All CAD 
systems can save drawings in DXF format and read (import) DXF drawings in many revisions of the 
format. If you don’t have CAD softwware, a handy utility to convert between DWG and DXF is 
AnyDWG DWG DXF Converter, which can be found here: httip://anydwg.com/dwg-dxf/

Coordinate systems
Most CAD drawings use a “float” (projected, X-Y) system in either metres or millimetres. If your GIS 
data is in a diffeerent coordinate system, reprojection is needed. For importing DXF drawings, your 
GIS project must be set up to match the coordinate system of the CAD. (Data can aftwerwards be 
copied between projects with diffeerent coordinate systems). 
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GPS Exchange files (GPX)
Modern GPS devices that act like external drives when connected to a computer via USB, store 
tracks and waypoints in .GPX filles. PlanetGIS can import and export GPX filles. Photographs 
referenced by GPX filles are handled in the same way as described in the next section.

Geotagged photographs (JPG)
“Smart” devices with a location sensor active, can “geotag” photographs that they take. Thee 
coordinate (latitude and longitude) of the device is stored inside the JPG fille, together with other 
camera information in a section called “Exif data”. You can check to see if a JPG image is geotagged 
by right-clicking on it in File Explorer and then click Properties and activate the Details tab. Thee 
latitude, longitude and altitude will be displayed in a section named “GPS” toward the bottiom of the 
list of image metadata.

You can import such JPG filles in the same way as you import other exchange filles in this chapter. 
(Only geotagged images will be imported. For importing images that are not geotagged, see the 
section on multimedia content in Attrributes). Point features will be created for each image and the 
images will be attiached to each feature and stored in the project database. Images can then be 
viewed by clicking on a feature and activating the Photos tab to the right of your map.

Most smart devices and digital cameras will also store the orientation of the device inside the Exif 
section. Softwware can then tell which edge of an image should be placed at the bottiom of a screen for
viewing (“Which way’s down?”).  PlanetGIS will automatically orientate images according to this 
information when importing them. You can also right-click on an image thumbnail to manually 
rotate it as needed. Thee actual date and time at which an image was taken is also stored in the Exif 
data and Planet extracts this and stores it as a Timestamp in the database2.

Spreadsheet information (CSV)
Any information contained in a spreadsheet must be saved as a CSV (Comma Separated Values) fille 
in order to import the information into PlanetGIS. Planet can also export features or attiribute 
information to CSV filles and can open your installed spreadsheet application automatically3 with 
any selected information.

CSV filles are “plain text” filles which you can open with, e.g. Notepad. Theere are some variations in 
the CSV format:

1. Thee actual character used to separate filelds (columns).  Normally a comma ( , ) but Microsoftw 
prefers using a semi-colon ( ; ). Another common separator is the [Tab] – an invisible 
character which text editor can interpret to be any amount of white-space, oftwen two or four 
spaces. 

2. Quioting of text values. Normally text without spaces, line breaks and quotation characters 
do not need to be quoted. Text containing any of the above must be quoted and nearly 
always the double-quote ( “ ) is used.

3. Decimal points. In some localities (e.g. Germany) a comma is used as the decimal separator 
for numbers with fractional digits.  In this case the use of a semi-colon to separate columns 
makes more sense.

2 Image editing softwware can lose or modify Exif information.  Thee Paint app in Windows 10, for example, preserves this
information while in previous versions of Windows any changes to a JPG were saved without Exif information. Thee 
date of the JPEG fille is not reliable because of image editing but will be used if Exif data is not present.

3 (If .CSV filles are associated with your spreadsheet application, which they normally are).
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4. Text encoding. Text filles always need some encoding system to be able to display text 
characters (stored as numbers on a computer) into visible “glyphs” (symbols). Theis encoding 
is usually not specifiled. Thee modern convention is to use the UTF-8 encoding and recently to
use two or three bytes at the beginning of such filles to indicate the variant of UTF-8 (or 
UTF-16).  Text filles created using older conventions can be in many diffeerent encodings. For 
regular latin lettiers, the ISO-8859-1 encoding is “safe” even for UTF-8 filles. Most people 
know this as simple “ASCII” or “ANSI” (though the lattier is a misnomer), but the important 
thing to remember about these is that the encoding is filxed for all characters that have 
numbers represented by 7 or fewer bits (numbers up to 127) and this includes the latin 
alphabet and most other characters on a “US” computer keyboard. If you don’t expect any 
other characters in your data, ISO-8859-1 is a safe choice.

5. Line endings. Planet handles both variants (Unix LF vs DOS CR+LF), but there is a small 
chance you’ll need to change the way that PlanetGIS writes CSV to Unix line endings.

In many cases you simply need to experiment with the above options and view the results in the 
Previe� tab. Thee most obvious problem occurs for mismatched column separators (commas) as you 
will see incorrect columns in the filrst tab if this settiing is incorrect.

Geo-databases
Planet can connect to most database systems and read spatial information directly. Thee Import 
table/SQL function in Design mode assists with the various forms in which this can be done.
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Chapter 11

THEMATIC MAPPING



Introduction
Thee true power of GIS presents itself with what is called “thematic mapping”. In the broadest sense a
thematic map is a map that illustrates a “theme” or, if you will, “tells a story”. More specifilcally, in 
PlanetGIS a thematic map is one that has at least one classifilcation of features into separate 
“thematic layers”. In Planet, this is called a “thematic query” because of the similarity to SQL queries.

It is possible to create thematic maps without using thematic queries. For example, to highlight a 
property boundary to stand out, you can simply copy it to a new feature class, add that class into a 
view and assign a (new) style to the display that stands out from other property boundaries. In this 
chapter we will not be doing that, but use attiributes to determine the appearance of the map. Thee 
advantage to this approach is that when the data changes, so does the map.

To create a thematic query, either use Tools→Theematic mapping→Create thematic query6 in 
Map Mode or use Design Mode to create thematic queries for a feature class (expand Feature classes 
and then the feature class on which you want to base the query and you will see a node called 
Thrematic queries – right-click, then Ne�→Theematic query).

Figure 86: Creating a thematic query in Design Mode

A thematic query will also, typically, be used in a new View, which must be set up to contain 
background mapping to provide context. Figure 87 shows the creation of a new view, which will be 
needed for the next example. Right-click on the last view tab and select Ne� vie�→Aftwer this 
vie�, then provide a name such as “Visited”.

Figure 87: Creating a new view

Thee next step will be to add context. In the Displays tab, add (for example) “Countries” and “Land 
cover”. Design mode can also be used to create views and to copy displays from other view by 
dragging and dropping.
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Select queries
Thee simplest type of thematic query is a “Select query”. Thee result is a single layer containing a 
subset of the feature class. Theis is basically a fillter used to highlight features based on constraints set
on one or more attiribute values.

Thee simplest select query is one used to highlight
features that have information in a detail table. Figure 
88 shows a query using the detail table we created in the
previous chapter. Thee query needs a descriptive name,
an attiribute or detail table and a type. Here the “Visits”
detail table is selected and the type set to “Select”.
Nothing more is required other than to run the query
and add it into a view. Theis .query warns the user that
the master column isn’t indexed, but with a small
project the speed degradation is not noticeable.

In the Displays tab, add the thematic (expand
“Countries” to see the new thematic). Now you will see
all countries with data in the “Visits” detail table stand
out with a solid colour. To change the style to
something else, right-click on the display and click 
Style properties6

To make changes to a query, you can also use the
Displays tab: right-click the display that references the
query and click Theematic query→Properties... at the bottiom.

Group queries
Group queries put features with the same attiribute values together in a sub-layer. In other words 
“classify by value”. An example of a group query is the query in the World map that gives each 
continent a unique colour.

Range queries
Range queries divide features based on numeric attiributes into predefilned ranges.

Pie and Bar charts
Pie and Bar charts are a variation of a group query, where a pie slice or a bar is a “classify by value” 
with another attiribute used to determine the relative sizes.
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